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Getting Started 
Welcome 

 

 

Thank you for choosing Garmin nRoute™! 

Garmin nRoute uses Garmin GPS technology integrated with a laptop or portable computer to provide you 
with navigational guidance.  You can use nRoute to perform the following tasks: 

• Create waypoints, routes, and tracks to help you navigate. 

• Find items, addresses, and Points of Interest included in the map data. 

• Gather information about your travels, including average speed, trip duration, etc. 

• Import and export data. 

WARNING: Do not attempt to enter route information or adjust this device while driving.  Failure to pay full 
attention to the operation of your vehicle could result in death, serious injury, or property damage.  You 
assume total responsibility and risk for using this software. 

This Help system provides you with basic instructions on how to use the features of nRoute. 

NOTE: The graphics in this Help system are optimized for monitor displays set at 1024 x 768 screen 
resolution.  Viewing this help system at resolution settings other than 1024 x 768 may result in reduced image 
quality. 

Your nRoute packaging includes a Setup Guide to help you install the software and set up your system 
properly. 

If you should encounter any difficulty while installing nRoute, or if you have any questions about nRoute, 
contact Garmin's Product Support Department at: 

913/397.8200 or 800/800.1020, Monday—Friday, 8 am—5 pm Central Time 

www.garmin.com  

For more information on getting started with nRoute, see the following topics: 

How Do I... 
Understanding the Interface 
Unlocking Maps  
Connecting the GPS Receiver  
Checking Satellite Status 
Setting Preferences  
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How Do I... 
This Help topic is designed to provide you with quick instructions on how to perform common nRoute tasks.   

…Hook Up the GPS Receiver? 

See Connecting the GPS Receiver.  Your nRoute Setup Guide also contains information on connecting your 
GPS receiver. 

 

…Know the GPS is Receiving Signals? 
Press F11 to activate the Satellites Tab to verify that the GPS is receiving signals.  See Checking Satellite 
Status for more information. 

 

…Find Myself on the Map? 

Click the Keep Vessel Visible  button to show your current location in the center of the map.  See Showing 
the Vehicle on the Map for more information. 

 

…Move the Map Around? 

Use the Hand tool  or the scroll bars at the bottom and right-hand side of the screen to move the map.  You 
can also zoom in and out to show portions of the map not currently displayed. 

 

…Change the Way the Map Looks? 

Select Preferences from the Edit menu, then click the Display tab.  From there, you can change many features 
of the map display, including the amount of visible detail.  See Setting Display Preferences for more 
information. 

To change the orientation of the map, click the Change Map Orientation button .  See Changing Map 
Orientation for more information. 

 

…Switch Maps? 

If you have multiple products installed, select the desired map from the Product list 

.  It may be necessary to unlock the desired map if you have not already done 
so.  NOTE: If you do not have additional maps installed, the Product list is not displayed.  See Unlocking 
Maps for more information. 

 

…Find Addresses, Intersections, or Items on the Map? 

Click the Find Places button , select the type of item you want to find from the Find Places window, then 
enter the desired information.  See Understanding the Find Feature for more information. 
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…Get Driving Directions to My Current Route Destination? 

When you have a route active, you can get driving directions using the following methods: 

• Check the InfoBar above the Graphic Map for the next maneuver along the route. 

• Press F9 to activate the Driving Directions Tab for a list of all the maneuvers along the active route. 

 

…Get Driving Directions for a Saved Route? 
Click the route name in the Saved Routes Tab, select Route Properties from the Edit menu, and then click 
the Directions tab.  See Editing a Route for more information. 

 

…Get the Voice to Speak? 

Press the Space Bar or click the Speak button  in the Utilities Toolbar. If you have a route activated, 
nRoute gives you voice instructions for the next maneuver.  If you do not have a route activated, nRoute tells 
you the satellite status. 

 

…Deactivate a Route? 

Click the Stop Route button  in the Routes Toolbar.  See Activating and Deactivating a Route for more 
information. 

 

…Track my Travel? 

Click the Tracks Tab (F6) and check the Record Track box  in the lower right-hand corner.  
See Recording a Track for more information. 

 

…Save Waypoints, Routes, or Tracks so I Can Open Them in MapSource? 

Select Export from the File menu, enter a file name, select the desired location on your computer to save the 
file, and click Save.  Your waypoints, routes, and tracks are saved on your computer.  See Saving Your Data 
for more information. 

 

…Delete Waypoints, Routes, Tracks, or Favorite Finds? 

Select the item you want to delete in the appropriate Information Tab, then click the Delete button . 

 

…Update nRoute Software? 
Check your software version number by selecting About nRoute from the Help menu.  To download the latest 
version of nRoute, select Go to nRoute's Software Update Web Page from the Help menu.  NOTE: An 
Internet connection is required to access the software update Web page. 
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Understanding the Interface 
The main nRoute interface screen consists of the following items: 

 

1. Menus—a variety of menus are displayed at the top of the screen.  These menus allow you to perform 
various tasks in nRoute, including activating toolbars, changing preferences for viewing the Graphic Map, 
creating and editing routes, and more.  See Menus in the Reference section for more information. 

2. Toolbars—toolbars are displayed near the top of the screen, directly below the menus.  You can toggle the 
toolbars on and off by selecting Toolbars in the View menu, then selecting the desired toolbar. You can also 
right-click on any toolbar and select the toolbars you want to show or hide.  See Toolbars in the Reference 
section for more information. 

3. InfoBar—the InfoBar appears above the Graphic Map.  While you are navigating, the InfoBar contains 
information about the next upcoming maneuver along your route.  See Using the InfoBar for more information. 

4. Graphic Map—the Graphic Map is your main navigation tool.  It displays the basemap and any detailed 
maps you have installed.  It also shows your current location (indicated by the Vessel icon), a map of the 
surrounding area, and any waypoints, routes, or tracks you have created and activated.  See Understanding the 
Graphic Map for more information. 

5. Information Tabs—the Information Tabs are displayed along the bottom of the screen.  The Information 
Tabs include Waypoints, Saved Routes, Tracks, Favorite Finds, Status, Driving Directions, Trip Computers, 
and Satellites.  Click the appropriate tab to view the desired information.  You can also press the corresponding 
Function (F) key on your keyboard to activate a tab.  Press F12 on your keyboard to show/hide all the 
Information Tabs. 

Click items in the Information Tabs to activate them on the Graphic Map, or right-click on an item to display a 
menu that allows you to perform various tasks.  See Right-Click Menus in the Reference section for more 
information. 

6. Status Bar—the Status Bar extends across the bottom of the nRoute window.  It displays a variety of 
information related to the action you are performing.  You can right-click on any toolbar to show or hide the 
Status Bar.  The Status Bar can show the following items: 
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• The number of tab items selected in a tab list. 

• The current Position Format and Map Datum (set in the Preferences window). 

• The latitude and longitude of the mouse pointer when positioned on the Graphic Map, regardless of which 
tool is selected.  If you are using map products that include elevation data, the elevation is shown next to 
the latitude and longitude. 

• When you click a waypoint in the Waypoints Tab, the Status Bar shows the distance and bearing from your 
current position to the selected waypoint. 

• If you are using the Distance/Bearing Tool, the Status Bar shows the distance and bearing from a beginning 
point to the selected point(s) on the map.  If you select more than two points, the Status Bar also shows the 
area between the points. 

• If you are using a Garmin GPS with Bluetooth® wireless technology, the lower left-hand corner of the 
Status Bar shows the GPS battery status.  See Checking GPS Battery Status for more information. 
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Unlocking Maps 
nRoute utilizes a basemap and detailed maps installed from MapSource products.  The type of detailed map 
data available depends on the map product(s) installed.  In order to access detailed map data, you must have the 
appropriate map product(s) installed and unlocked.  If you have multiple MapSource products installed and 
unlocked on your computer, you can use many of them with nRoute.   

NOTE: nRoute cannot be used with BlueChart or MetroGuide 5. 

Your MapSource product contains instructions on how to install and unlock detailed maps. 

When you open nRoute, the application automatically detects whether you have unlocked the maps installed on 
your computer. 

You can use the UnlockWizard to unlock MapSource regions, to redeem an 8-character coupon code, to unlock 
maps for a second GPS unit, and to purchase additional unlock codes. 

To unlock a map region: 
1. Select Unlock Regions from the Utilities menu or press Ctrl+U.  The UnlockWizard opens.  Click Next to 

advance to the next screen. 

2. If you have a 25-character unlock code, select Yes, I have a 25-character Unlock Code. 

3. If you have an 8-character coupon code, want to unlock maps for a second GPS unit, or want to purchase 
an additional unlock code with your credit card, select No, I need to get a 25-character Unlock Code.  
NOTE: This option requires an Internet connection. 

4. Click Next, then follow the steps on the screen. 

 

To switch MapSource products: 
If you have more than one MapSource product installed, you can select the desired MapSource product from 
the product selector 

.    
NOTE: If you have only one MapSource product installed, the product selector is not displayed. 
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Connecting the GPS Receiver 
Many features of nRoute will work even if the GPS is disconnected.  However, in order for nRoute to 
accurately perform some functions, the GPS must be connected and receiving signals from GPS satellites. 

To connect the GPS receiver: 
Connect the GPS into the appropriate port (serial or USB) on your computer. 

• If you are using a Garmin GPS with Bluetooth® wireless technology, make sure the Bluetooth software on 
your PC is properly configured.  nRoute will connect to your GPS device with Bluetooth wireless 
technology via a COM port.  See your Garmin GPS owner's manual and your Bluetooth software owner's 
manual for more information. 

• If you have never used nRoute before, click Select Device , select the appropriate port (serial or USB), 
and click OK.  If you are using a serial GPS or a GPS with Bluetooth wireless technology, you can click 
AutoDetect to have nRoute automatically detect the device.   

• If you have used nRoute before, but without a GPS connected, nRoute prompts you to select a receiver.  
Select the appropriate device (serial or USB) and click OK. 

• If you have previously connected the GPS to your computer using nRoute, nRoute begins to acquire 
satellites and the message "Searching for Satellites" appears in the InfoBar. 

• If you are using a serial GPS, verify that it is plugged in to the vehicle's 12-volt receptacle and is receiving 
power. 

• If there is a discrepancy between the GPS's clock and the clock on your computer, nRoute prompts you to 
select the correct time.  If you select GPS, nRoute changes the clock on your computer to match the GPS's 
time.  NOTE: The GPS's time is not necessarily correct if you are connecting it for the first time or if it has 
not been used for a while. 

• When you connect your GPS for the first time, or if you have traveled more than 600 miles with the 
receiver turned off, the initialization process may take several minutes to determine your location. 

• To shorten the initialization time, click the Selection tool , right-click on your approximate location on 
the Graphic Map, and select Set Current Location. 

After a few moments, nRoute acquires satellites and the message "Ready to Navigate" appears in the InfoBar.  
See Checking Satellite Status for more information. 

NOTE: If you are using a serial GPS on a computer with a Windows operating system, you may experience 
erratic mouse movements.  This is because Windows may be identifying your GPS as a serial mouse.  If this 
happens, follow the steps below: 

1. Unplug the serial GPS. 

2. From the desktop, right-click the My Computer button and select "Properties." 

3. Click the Hardware tab, then click Device Manager (in Windows 98, click the Device Manager tab). 

4. Double-click "Mice and other pointing devices." 

5. Right-click on "Serial ballpoint mouse" and select Disable. 

6. Close the Device Manager. 
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A sensor configuration program is available on the Garmin Web site to further configure your GPS.  See the 
GPS 18 Tech Specs document (GPN 190-00307-00, also available on the Garmin Web site) for more 
information. 
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Checking Satellite Status 
After connecting your GPS receiver, you can check the Satellites Tab to verify that your GPS is acquiring 
satellites.  The Satellites Tab appears along the bottom of the screen.  It shows the satellites your GPS has 
acquired, their signal strength, the accuracy of navigation, and your current position.  You can activate the 
Satellites Tab by clicking on it or pressing F11 on your keyboard. 

 

nRoute can utilize WAAS (Wide Area Augmentation System), provided your GPS is enabled to receive 
WAAS satellites.  WAAS technology is a system of satellites and ground stations that provide GPS signal 
corrections, giving you better position accuracy.  WAAS is most effective in the U.S.A.  If you are located in 
another part of the world, it is recommended that you turn off WAAS for the most accurate location fix.  See 
What is WAAS? on the Garmin Web site for more information. 

The Satellites Tab contains the following features: 

Connection Status—the Connection Status field contains information about the type of signal that your GPS is 
receiving.  If your GPS is not connected, the message "Attempting Connection to Unit" appears.  When your 
GPS is connected, the message "Searching for Satellites" appears.  Based upon the satellites your GPS 
receives, one of the following connection status messages appears:   

Poor GPS Coverage—your GPS is receiving fewer than three GPS satellites and cannot 
determine your location accurately. 

2D Navigation—your GPS is receiving three GPS satellites and has determined your 2D location 
(latitude and longitude). 

2D Differential—your GPS is receiving three GPS satellites, one of which is a WAAS satellite. 

3D Navigation—your GPS is receiving four or more GPS satellites and has determined your 3D 
location (latitude, longitude, and elevation). 

3D Differential—your GPS is receiving four or more satellites and has determined your 3D 
location (latitude, longitude, and elevation) with WAAS enabled. 

GPS Signal Strength—this graph indicates the strength of the GPS signal being received from each 
corresponding numbered satellite.  Satellites numbered 32 and below are GPS satellites, while satellites 
numbered greater than 32 are WAAS satellites. 

GPS Satellite Location View—these large white circles show the positions of satellites in the sky overhead, 
with the center of the circles representing your current position.  The outer circle indicates the horizon; the 
inner circle indicates a position 45° from the horizon.  The small, numbered circles indicate the satellites and 
the numbers assigned to them.  These small circles turn green to indicate that a satellite is being used to 
determine your location.  Yellow indicates a satellite has been located but is still initializing, and is not yet 
being used to determine your location.  White indicates that no signals are being received. 

Accuracy—the accuracy of the GPS system. 
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Enable/Disable WAAS—enable WAAS to increase the accuracy of your GPS system, or disable WAAS for 
faster initialization, to preserve battery power, or if WAAS is not available in your area.  See What is WAAS? 
on the Garmin Web site for more information.  

Position—your current position in latitude and longitude. 

Date/Time—the current date and time. 

nRoute automatically attempts to acquire satellites if you have a GPS unit connected to your computer.  If your 
GPS does not acquire satellites: 

• Make sure your GPS is connected properly to your computer.  See Connecting the GPS Receiver for more 
information. 

• Verify that your GPS is unobstructed. Solid materials (except untinted glass), tall buildings, and dense 
overhead tree cover can block satellite signals. In order to receive satellite signals, you must be outdoors or 
in a vehicle and have a clear view of the sky. 

• Make sure the GPS has enough time to initialize. When the GPS initializes for the first time, or if you have 
traveled more than 600 miles with the GPS turned off, the initialization process may take several minutes. 

• If you are using a serial GPS, verify that it is plugged in to the 12 volt receptacle and is receiving power. 

• Try disconnecting the GPS from your PC and reconnecting it. 

• Try closing and re-opening nRoute. 

• Try uninstalling and re-installing nRoute. 

You can simulate GPS signals by selecting Simulate a GPS from the Utilities menu.  This feature can be used 
to simulate driving a route.  See Simulating a Route for more information. 
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Checking GPS Battery Status 
If you are using a Garmin GPS with Bluetooth® wireless technology, nRoute shows the GPS unit's remaining 
battery power in the bottom right-hand corner of the Status Bar. One of the following icons appears: 

Battery Power —Indicates that the GPS unit is operating on battery power.  The green bars show the 
remaining battery power. 

Charging Battery —Indicates that the GPS unit is connected to an external power supply and the 
battery is charging. 

External Power —Indicates that the GPS unit is connected to an external power supply and the battery 
is fully charged. 

The name of the GPS unit (for example, "GPS 10") appears next to the icon. 

To view the exact percentage of remaining battery power, hold the mouse pointer over any of the icons. 

You can only view GPS battery status when using a Garmin GPS with Bluetooth® wireless technology. 
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Using the Graphic Map 
Understanding the Graphic Map 
The Graphic Map is nRoute's main navigation tool.  nRoute displays the basemap and any detailed maps you 
select in MapSource.  The basemap contains major cities, roads, and highways, while detailed maps contain 
smaller streets, addresses, intersections, and Points of Interest. 

 

1. The Vessel icon  indicates your position and heading on the Graphic Map.   

2. Waypoints are displayed by symbol and by name.   

3. Points of Interest are displayed as symbols.  The names of some Points of Interest are displayed on the 
map in a different font than waypoint names. 

4. Active routes are displayed as colored lines on the map.  The beginning point of the route is green; the 
ending point of the route is red. 

Graphic Map Tips   

• To view the name of a Point of Interest, click the Selection Tool , then hold the mouse cursor over the 
desired Point of Interest on the map. 

• If multiple items are displayed at a single location on the Graphic Map, right-click on the location, then 
select the desired item from the list that appears. 

• You can perform a variety of tasks by right-clicking on the Graphic Map.  See Map Feature Right-Click 
Menu for more information. 

• The Information Tabs across the bottom of the screen show waypoints, routes, and tracks.  To display an 
item on the Graphic Map, right-click on the item in the appropriate Information Tab and select Show 
Selected Item on Map. 

• Click the Keep Vessel Visible button  to center the Vessel icon on the map. 

• Click the Keep Maneuver Visible button  to show the next maneuver on the map while you are 
navigating on a route. 
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• If you move the map, zoom in or out, or display a different area on the Graphic Map while the Keep 
Vessel Visible and/or Keep Next Maneuver Visible buttons are selected, nRoute automatically deselects 
those buttons so that you can manipulate the map as needed.  After you have finished moving the map, 
click the Keep Vessel Visible and/or Keep Maneuver Visible buttons again to re-activate. See Showing 
the Vehicle on the Map for more information. 

• The Graphic Map can be oriented to display in either "North Up" or "Track Up" mode.  See Changing Map 
Orientation for more information. 

• You can change the color of the text and the background of the Graphic Map by setting your display 
preferences. 

• You can show or hide the toolbars, InfoBar, Status Bar, and Information Tabs by right-clicking on any 
toolbar and checking or unchecking the desired item. 

For more information on the Graphic Map, see the following topics: 

Setting Display Preferences  
Moving the Graphic Map  
Zooming In and Out on the Map 
Showing the Vehicle on the Map  
Changing Map Orientation  
Using the InfoBar  
Using the Status Tab  
Using the Trip Computers Tab  
Saving Your Data 
Opening Saved Data  
Legend: Businesses and Attractions  
Legend: Points of Interest  
Legend: Map Lines  
Legend: Map Areas  
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Moving the Graphic Map 
There are several methods for moving (or "panning") the Graphic Map to view portions of the map not 
currently displayed on the screen: 

• Click the Hand Tool , move the mouse cursor over the Graphic Map, then click and hold the left 
mouse button and move the mouse in the direction you want to move the Graphic Map. 

• Use the scroll bars on the right side and at the bottom of the Graphic Map. 

• Click any point on the Graphic Map, then use the Up, Down, Left, and Right arrow keys on the keyboard 
to move the map short distances.  Hold down the Ctrl key while pressing the arrow keys to move longer 
distances. 

• Click the Zoom Tool , then hold down the Ctrl key and click the desired point on the Graphic Map. 
The selected point is displayed in the center of the map. 
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Zooming In and Out on the Map 
The more you zoom in on the Graphic Map, the more details (streets, map features, Points of Interest, etc.) are 
displayed.  

NOTE: You can set the amount of detail displayed on the Graphic Map by using the Display Preferences 
window. 

There are several methods for zooming in and out on the Graphic Map: 

• Click the Zoom In  and Zoom Out  buttons. 

• Select the desired map scale using the Map Scale Selector  . 

• Click the Zoom Tool , move the mouse cursor over the Graphic Map, then click and hold the left 
mouse button and move the mouse cursor to draw a box around the area you want to zoom in on.  The 
smaller the box, the more the map will zoom in. 

• With the Zoom Tool selected, you can also click the left mouse button to zoom in incrementally and the 
right mouse button to zoom out incrementally. 

• Select Zoom Scale from the View menu, then select the desired map scale. 

• Press the Plus (+) and Minus (-) keys on your keyboard to zoom in and out. 
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Printing the Graphic Map 
You can print the current Graphic Map display, including routes, tracks, waypoints, and map detail (if 
available).  You may need to adjust your printer's dpi settings in order to print the Graphic Map display. 

• Select Print Setup from the File menu to select a printer and set printing options. 

• Select Print Preview from the File menu to show a preview of the document you wish to print. 

• Select Print from the File menu to print the current Graphic Map display. 
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Showing the Vehicle on the Map 

You can set nRoute to keep your vehicle (shown by the Vessel icon ) visible on the map while you are 
navigating along a route.  In addition, you can set nRoute to automatically zoom in and out on the map so that 
you can see the next maneuver along the route. 

• Click the Keep Vessel Visible button  to center the Vessel icon on the map.  If you leave this button 
selected, the Vessel icon stays visible on the map as you navigate along the route. 

• Click the Keep Next Maneuver Visible button  to automatically show the next maneuver while 
navigating along a route. 

• Click both buttons or press Ctrl+B to keep the Vessel icon visible on the map and automatically zoom in 
and out to show the next maneuver along the route. 

NOTE: If you move the map, zoom in or out, or display a different area on the Graphic Map while either the 
Keep Vessel Visible and/or Keep Next Maneuver Visible buttons are selected, nRoute automatically 
deselects those buttons so that you can manipulate the map as needed.  After you have finished moving the 
map, click the Keep Vessel Visible and/or Keep Maneuver Visible buttons again to re-activate. 

 20 



Changing Map Orientation 
The Graphic Map can be oriented to display in either "North Up" or "Track Up" mode. 

North Up 

North Up means North is always towards the top of the screen.  When you turn, your Vessel icon turns to 
indicate which direction you are heading. 

 

 

Track Up 
Track Up orients the Graphic Map in the direction of travel with the Vessel icon always pointing towards the 
top of the screen.  When you turn, the Graphic Map redraws the map to show which direction you are heading, 
but the Vessel icon remains pointed towards the top of the screen.  In Track Up mode, an arrow appears in the 
upper left-hand corner of the Graphic Map indicating which way is North. 

 

 

There are three ways to change map orientation: 

• Click the Change Map Orientation button  in the View toolbar. 

• Select Change Orientation in the View menu. 

• Press Ctrl+O. 

NOTE: If you move the map, zoom in or out, or display a different area on the Graphic Map while in Track 
Up mode, nRoute automatically stops redrawing the map so that you can manipulate the map as needed.  After 
you have finished moving the map, change the map orientation to North Up, then back to Track Up to re-
activate Track Up mode. 
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Using the InfoBar 
The InfoBar appears above the Graphic Map.  You can resize the InfoBar by clicking on its bottom border and 
dragging it up or down.  You can hide or show the InfoBar by right-clicking on any toolbar and checking or 
unchecking the InfoBar option. 

 

The InfoBar displays the following messages: 

• If you do not have a GPS connected to your computer, the InfoBar displays the message "Attempting 
connection to GPS." 

• If you have an active route but do not have a GPS connected, the InfoBar displays the message "Please 
connect GPS to start route." 

• If you have a GPS connected, but it has not acquired satellites, the InfoBar displays the message 
"Searching for satellites." 

• If you have a GPS connected and it has acquired satelltes, the InfoBar displays the message "Ready to 
Navigate." 

• While you are navigating along an active route, the InfoBar contains information about the next maneuver 
on your route, including the estimated distance and time to the next maneuver. 

• If you do not have a route active, the InfoBar defaults to display your current heading and speed, as well as 
the upcoming cross street. 

You can customize the information displayed in the InfoBar by changing InfoBar Preferences. 

To change InfoBar preferences: 
1. Select Preferences from the Edit menu, then click the InfoBar tab.  The InfoBar Preferences window 

appears. 
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2. Select the desired options for the information displayed in the two rightmost fields while routing (navigating 
with an active route): 

Accuracy—shows the accuracy of the GPS. 

Dist (Destination)—shows the distance to your destination. 

Dist (Maneuver)—shows the distance to the next maneuver. 

Elevation—shows your current elevation. 

ETA (Destination)—shows the estimated time of arrival at your destination. 

ETA (Maneuver)—shows the estimated time of arrival at the next maneuver. 

Heading—shows your current heading. 

Speed—shows your current speed. 

Time (Destination)—shows the total time remaining until you reach your destination. 

Time (Maneuver)—shows the total time remaining until the next maneuver. 

Time of Day—shows the current time of day. 

3. Select the desired options for the information displayed in the two rightmost fields while not routing (no 
active route): 

Accuracy—shows the accuracy of the GPS. 

Elevation—shows your current elevation. 

Heading—shows your current heading. 

Speed—shows your current speed. 

Time of Day—shows the current time of day. 

4. Click OK to save your changes. 
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Using the Status Tab 
The Status Tab shows your current speed, direction, and elevation.  You can access the Status Tab by clicking 
on it or pressing F8 on your keyboard. 

 

The Status Tab includes the following features: 

Speed—your current speed. 

Heading—your current heading. 

Elevation—your current elevation. 

Address—the street address closest to your current location. 

Next Street—the next cross street you are approaching. 

Compass—the red line indicates North.  The green line at the top of the compass indicates your current 
heading.  When you are navigating on a direct route, a black arrow showing the direction to the next waypoint 
appears on the compass.  See Understanding Routes for more information. 

Dist (Maneuver)—the estimated distance to the next maneuver in the route. 

Dist (Destination)—the estimated distance to the end of the route. 

Time (Maneuver)—shows the total time remaining until the next maneuver. 

Time (Destination)—shows the total time remaining until you reach your destination. 

ETA (Maneuver)—the estimated time of day you will arrive at the next maneuver. 

ETA (Destination)—the estimated time of day you will arrive at the end of the route. 
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Using the Trip Computers Tab 
The Trip Computers Tab keeps track of your speed, time, and mileage while you are navigating.  You can 
access the Trip Computers Tab by clicking on it or pressing F10 on your keyboard. 

You can have multiple trip computers running at the same time, and each can be stopped and started 
individually.  For example, you can have multiple trip computers recording information for a trip across the 
country.  You can start a different trip computer for each leg of the trip while your original trip computer keeps 
track of the trip as a whole. 

 

The Trip Computers Tab contains the following features: 

Trip Name—the name of the trip computer that is currently displayed.  If you want to continue a previous trip, 
click the drop-down arrow and select the desired trip. 

Trip Odometer—the total mileage you have accumulated on the trip. 

Avg Speed—your average speed during trip, including stopped time. 

Driving Avg—your average speed while your vehicle is in motion during the trip (does not include stopped 
time). 

Max Speed—your maximum speed during the trip. 

Moving Time—the total time your vehicle was in motion during the trip. 

Stopped Time—the total time your vehicle was stopped during the trip. 

Trip Time—the total time elapsed during your trip. 

Reset—click to reset all the above fields to zero. 

Start/Stop—click to start and stop the trip computer. 

New—to start a new trip, click this button, enter the name for your new trip, and click OK.  The trip computer 
is reset, and the name of the new trip appears in the Trip Name field. 

Delete—to delete the active trip, click this button, then click OK.  The active trip is deleted. 
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Saving Your Data 
Data in nRoute is automatically saved and will be loaded whenever you start nRoute.  Any waypoints, routes, 
and tracks you have created using nRoute can also be saved on your computer.  These files can be used to back 
up your data or share data with Garmin MapSource.  You can save files as .gdb (default) or .mps files. 

To save waypoints, routes, and tracks: 
1. Select Export File from the File menu. 

2. Select the file type in the Save as type field. 

3. Enter a file name and select the desired location on your computer to save the file. 

4. Click Save.  The file is saved. 
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Opening Saved Data 
You can open saved .gdb, .mps, or .gpx files in nRoute and import waypoints, routes, and tracks from the saved 
file.  When you open file, nRoute merges the saved data with your current data. 

To open a saved file: 
1. Select Import File from the File menu. 

2. Select the desired file type in the Files of type field. 

3. Browse to the desired file on your computer. 

4. Click Open.  The file opens in nRoute. 

You can also open saved .gdb, .mps, or .gpx files in nRoute by dragging and dropping the file directly from 
Windows Explorer onto the nRoute screen. 
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Setting Display Preferences 
You can customize the way the Graphic Map appears, including the level of map detail, visible routes, and 
colors. 

To set display preferences: 
1. Select Preferences from the Edit menu.  The Preferences window appears. 

2. Click the Display tab.  The Display Preferences tab appears. 

 

3. Make the desired changes to the following fields: 

Map Detail—move the slider to adjust the amount of detail (streets, Points of Interest, waypoints, etc.) 
displayed on the Graphic Map. 

Services—Use this option to display services and Points of Interest if they are loaded as part of your 
detailed maps.  Select Automatic to display these items when the map is zoomed in to a low scale.  Select 
On to display these items regardless of the map zoom scale.  Select Off if you do not want these items 
displayed. 

Colors—this item changes the color of the text and background of the Graphic Map and the Information 
Tabs.  Select Day for a light background with darker text, Night for a dark background with lighter text, or 
Automatic to automatically switch between the Day and Night settings at the appropriate time of day. 

Lock to Roads—select On to keep the Vessel icon attached to the nearest road on the map, or select Off 
to allow the Vessel icon to go off-road. 

Show Tracks—select All to show all tracks, Active to show only the active track, or None to show no 
tracks. 

Show Routes—select All to show all saved and active routes or Active to show only the active route. 

Vessel Size—select the size of the Vessel icon displayed on the Graphic Map. 
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Light Sectors (BlueChart users)—use this option to toggle Light Sectors on or off. 

Spot Soundings (BlueChart users)—use this option to toggle Spot Soundings on or off. 

Change Map Font—click this button to select a new font, style, and size for map text.  

4. Click OK to save your changes. 
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Legend of Map Symbols 
Legend: Businesses and Attractions 
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Legend: Points of Interest 
 

 

 31



Legend: Map Lines 
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Legend: Map Areas 
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Using the Find Feature 
Understanding the Find Feature 
The Find feature allows you to search for any Map Feature (addresses, waypoints, Points of Interest, etc.) and 
create a route to it.  All Find Items are part of the basemap (which contains major cities) and detailed map data 
(which contains addresses, map features, and Points of Interest).  The type of detailed map data available 
depends on the map product(s) installed.  See Unlocking Maps for more information. 

Find Feature Tips 

• Click the Find Places button  to locate cities, map features/Points of Interest, addresses, intersections, 
and waypoints.  You can find items by entering the item's name (if known) and by selecting categories to 
find certain types of items.  This feature provides you with an ordered list of items that meet your search 
criteria.  See Finding Cities, Finding Map Features/Points of Interest, Finding Addresses, Finding 
Intersections, and Finding Waypoints for more information. 

• Click the Find Nearest button  to locate items near your current location.  This feature lists items 
based on how close they are to you.  You can select categories to find certain types of items and also use 
the "Containing" field to find an item based on all or part of the item's name.  See Finding Items Near Your 
Current Location for more information. 

• Click the Recently Found Places button  to view a list of the last few items you found.  nRoute keeps 
track these items case you want to find them again quickly.  See Finding Recently Found Places for more 
information. 

• You can save your Favorite Finds to create a list of items you commonly search for and find these items 
quickly.  See Understanding the Favorite Finds Feature for more information. 

• If you are having difficulty finding a Point of Interest, try typing only the first few letters in the Name field.  
For example, if you are searching for a store called "Sam-Mart", type "Sam".  You can also try different 
spellings of the name.  If the name includes special characters (hyphens, apostrophes, "&" symbols, etc.), 
try including the special characters in your search, then try searching for the name without them. 

For more information on the Find feature, see the following topics: 

Finding Cities  
Finding Map Features/Points of Interest 
Finding Addresses  
Finding Intersections  
Finding Waypoints  
Finding Items Near Your Current Location  
Finding Recently Found Places  
Finding a Latitude/Longitude Position  
Setting Find Preferences 
Understanding the Favorite Finds Feature  
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Finding Map Features / Points of Interest 
Map features and Points of Interest are contained in detailed mapping data. 

To find map features/Points of Interest: 

1. Click the Find Places button , then click the Feature tab. 

 

2. If you want to clear information you entered previously, click Reset. 

3. Select the desired Place Category and, if desired, Place Subcategory. 

4. If you know the name of the Point of Interest you want to find, enter the name in the Name field.  As you 
type, an Auto Complete list of nearest matches appears below the field.  You may type the entire name of 
the Point of Interest or type the first few letters and select the name from the list. 

NOTE: If you are having difficulty finding a Point of Interest, try typing only the first few letters in the Name 
field. For example, if you are searching for a store called "Sam-Mart", type "Sam". 

5. Enter the City, State/Province, and Country to refine your search, if desired. 

6. Click the Find button.  A list of Points of Interest appears in the Places field. 

7. Click the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic Map. 

8. After selecting the desired Point of Interest, you can do any of the following: 

• To view the address, telephone number, and the Place Category and Subcategory of the Point of 
Interest, click the Properties button. 

• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window 
appears.  See Editing Waypoint Properties for more information.  

• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your 
current location to the selected Point of Interest. 
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• To close the Find Places window and leave the selected Point of Interest centered on the Graphic 
Map, click OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Finding Cities 
Major cities are part of the basemap loaded on your computer. 

To find a city: 

1. Click the Find Places button , then click the City tab. 

 
2. If you want to clear information you entered previously, click Reset. 

3. Enter the name of the city in the City field.  As you type, an Auto Complete list of nearest matches appears 
below the field.  You may type the entire name of the city or type the first few letters and select the name 
from the list. 

4. Enter the State/Province and Country to refine your search, if desired. 

5. Click the Find button.  A list of cities appears in the Places field. 

6. Click the desired city in the list.  The selected city is centered on the Graphic Map. 

7. After selecting the desired city, you can do any of the following: 

• To mark the city as a waypoint, click Make Waypoint.  The Waypoint Properties window appears.  See 
Editing Waypoint Properties for more information.  

• To create a route to the city, click Route To It.  nRoute generates a route from your current location to 
the selected city. 

• To close the Find Places window and leave the selected city centered on the Graphic Map, click OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Finding Addresses 
Addresses are contained in detailed mapping data. 

To find an address: 

1. Click the Find Places button , then click the Address tab. 

 

2. If you want to clear information you entered previously, click Reset. 

3. Enter the Number of the address. 

4. Click the Select button next to the Street field, then enter the desired street name (or street number) 
without any prefix or suffix.  For example, to find "N 140th Street," enter "140th." 

5. Select the desired street from the list, then click Select Street.   

6. If you want your search to cover only a specific area, enter the desired City, State/Province, Postal Code, 
and/or Country. 

7. Click the Find button.  A list of addresses appears in the Places field. 

8. Click the desired address in the list.  The selected address is centered on the Graphic Map. 

9. After selecting the desired address, you can do any of the following: 

• To mark the address as a waypoint, click Make Waypoint.  The Waypoint Properties window appears.  
See Editing Waypoint Properties for more information.  

• To create a route to the address, click Route To It.  nRoute generates a route from your current 
location to the selected address. 

• To close the Find Places window and leave the selected address centered on the Graphic Map, click 
OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Finding Intersections 
Intersections are contained in detailed mapping data. 

To find an intersection: 

1. Click the Find Places button , then click the Intersection tab. 

 

2. If you want to clear information you entered previously, click Reset. 

3. Click the Select button next to the First Street field, then enter the desired street name (or street number) 
without any prefix or suffix.  For example, to find "N 140th Street," enter "140th." 

4. Select the desired street from the list, then click Select Street.   

5. Click the Select button next to the Second Street field, then enter the desired street name (or street 
number). 

6. Select the desired City, State/Province, Postal Code, and/or Country to refine your search, if desired. 

7. Click the Find button.  A list of intersections appears in the Places field. 

8. Click the desired intersection in the list.  The selected intersection is centered on the Graphic Map. 

9. After selecting the desired intersection, you can do any of the following: 

• To mark the intersection as a waypoint, click Make Waypoint.  The Waypoint Properties window 
appears.  See Editing Waypoint Properties for more information.  

• To create a route to the intersection, click Route To It.  nRoute generates a route from your current 
location to the selected intersection. 

• To close the Find Places window and leave the selected intersection centered on the Graphic Map, 
click OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Finding Waypoints 
You can use the Find feature to find any waypoints you have created.  See Marking Waypoints for more 
information. 

To find a waypoint: 

1. Click the Find Places button , then click the Waypoint tab. 

 

2. Enter the name of the waypoint in the Name field.  As you type, an Auto Complete list of nearest matches 
appears below the field.  You may type the entire name of the waypoint or type the first few letters and 
select the name from the list. 

3. Click the Find button.  A list of waypoints appears in the Places field. 

4. Click the desired waypoint in the list.  The selected waypoint is centered on the Graphic Map. 

5. After selecting the desired waypoint, you can do any of the following: 

• To view the properties of the waypoint, click the Properties button.  The Waypoint Properties window 
appears.  See Editing Waypoint Properties for more information. 

• To create a route to the waypoint, click Route To It.  nRoute generates a route from your current 
location to the selected waypoint. 

• To close the Find Places window and allow the selected waypoint to remain centered on the Graphic 
Map, click OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Finding Items Near Your Current Location 
If your GPS is connected and has acquired satellites, nRoute allows you to find Points of Interest near your 
current location.  If your GPS is not connected or has not acquired satellites, nRoute finds items near your last 
known location. 

You can find items near your current location by selecting the desired Place Categories and Subcategories.  If 
you know the name of the item you are looking for, you can quickly find it by entering all or part of the name 
of the item in the Containing field. 

To find items near your current location: 

1. Click the Find Nearest button .  The Find Nearest Places window appears. 

 

2. Select the desired Place Category and, if desired, Place Subcategory. 

3. Enter the Maximum Search Distance in miles.  This is the radius of your search area from your current 
location. 

4. Enter the name (or part of the name) of the Point of Interest in the Containing field, if desired.  For 
example, to find the nearest Texaco gas station, enter "Texaco" in the Containing field.  

NOTE: If you are having difficulty finding a Point of Interest, try typing only the first few letters in the Name 
field.  For example, if you are searching for a store called "Sam-Mart", type "Sam". 

5. Click the Find button.  A list of Points of Interest appears in the Places field. 

6. Click the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic Map. 

7. After selecting the desired Point of Interest, you can do any of the following: 

• To add the item to your Favorite Finds, click Save as Favorite.  The Favorite Find Properties window 
appears.  See Adding an Item to Your Favorite Finds for more information. 

• To view the address and telephone number of the Point of Interest, click the Properties button. 

• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window 
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appears.  See Editing Waypoint Properties for more information.  

• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your 
current location to the selected Point of Interest. 

• To close the Find Nearest Places window and leave the selected Point of Interest centered on the 
Graphic Map, click OK. 

• To close the Find Nearest Places window and return to the previous map display, click Cancel. 
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Finding Recently Found Places 
nRoute keeps track of items you recently found in case you want to find them again quickly. 

To find recently found items: 

1. Click the Recently Found Places button .  The Recently Found Places window appears. 

 
2. Click the desired item in the list.  The selected item is centered on the Graphic Map. 

3. After selecting the desired item, you can do any of the following: 

• To view the address and telephone number of the item, click the Properties button. 

• To mark the item as a waypoint, click Make Waypoint.  The Waypoint Properties window appears.  
See Editing Waypoint Properties for more information.  

• To create a route to the item, click Route To It.  nRoute generates a route from your current location to 
the selected item. 

• To close the Recently Found Places window and leave the selected item centered on the Graphic 
Map, click OK. 

• To close the Recently Found Places window and return to the previous map display, click Cancel. 
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Finding a Latitude/Longitude Position 
You can find a position on the Graphic Map by entering the desired latitude and longitude. 

To find a latitude/longitude position: 
1. Select Go To Position from the View menu.  The Go To Position window appears. 

 

2. Enter the desired latitude and longitude and click OK.  The Graphic Map centers on the position you 
entered. 

 46 



Setting Find Preferences 
You can change the number of items displayed in the Find list and in the Recently Found Places list by setting 
your Find preferences. 

To set find preferences: 
1. Select Preferences from the Edit menu.  The Preferences window appears. 

2. Click the Find tab.  The Find Preferences tab appears. 

 

3. Make any desired changes to the following fields: 

Show this many found places—enter the number of items you want displayed in the Find list when you 
are searching for an item. 

Remember this many found places—enter the number of items you want displayed in the Recently 
Found Places list. 

Show this many Find Places Auto Complete results—enter the number of items you want to appear in 
the Auto Complete list when you are entering information in the Find Places window. 

4. Click OK to save your changes. 
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Using the Favorite Finds Feature 
Understanding the Favorite Finds Feature 
The Favorite Finds feature allows you to save your Find Nearest Places search criteria.  You can use the 
Favorite Finds feature to create a list of "favorites"—items you commonly search for—and find these items 
quickly. 

Favorite Finds store Category, Subcategory, and Maximum Search Distance information so that you do not 
have to re-enter the data each time you wish to find an item.  You can also specify your Favorite Finds by 
name.  For example, you can create Favorite Finds to locate the nearest Texaco gas station or Hilton hotel. 

Items you add to your Favorite Finds are displayed in the Favorite Finds Tab at the bottom of the screen.  
nRoute also includes some default Favorite Finds such as "Nearest Fast Food," "Nearest Gas Station," "Nearest 
Hospital," and "Nearest Coffee Shop."  You can modify or delete these default Favorite Finds as desired. 

For more information on the Favorite Finds feature, see the following topics: 

Using the Favorite Finds Tab  
Adding an Item to Your Favorite Finds  
Finding an Item Using the Favorite Finds Feature  
Editing a Favorite Find  
Deleting a Favorite Find  
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Using the Favorite Finds Tab 
The Favorite Finds Tab lists all the Favorite Finds you have saved.  You can access the Favorite Finds Tab by 
clicking on it or pressing F7 on your keyboard. 

 

You can perform a variety of tasks by right-clicking on items in the Favorite Finds tab.  See Favorite Finds 
Right-Click Menu for more information. 

The Favorite Finds Tab includes the following fields: 

Name—the term or phrase used to describe the Favorite Find.  NOTE: nRoute does not use this "name" when 
finding the item.  If you want nRoute to search for an item by name, enter the appropriate information in the 
Containing field when you create your Favorite Find. 

Type—the category of items the Favorite Find searches for (Food & Drink, Services, All Points of Interest, 
etc.) 
Subtype—the subcategory of items the Favorite Find searches for (Hotels, Auto Fuel, All Subcategories, etc.) 
Distance—the radius of your search area from your current location. 
Containing—all or part of the name of the item you want the Favorite Find to search for. 
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Adding an Item to Your Favorite Finds 
To add an item to your Favorite Finds: 
1. Select New Favorite Find from the Find menu.  The Favorite Find Properties window appears. 

 

2. Enter an appropriate descriptive term or phrase for your Favorite Find, i.e. "Nearest Gas Station," "Nearest 
Italian Restaurant," "Nearest Applebee's," etc.  NOTE: nRoute does not use the name entered in this field 
when finding the item.  If you want nRoute to find an item by name, enter the name of the item in the 
Containing field. 

3. Select the appropriate Place Category and, if desired, Place Subcategory. 

4. Enter the Maximum Search Distance in miles.  This is the radius of your search area from your current 
location. 

5. If you want nRoute to find the item by name, enter the name of the item in the Containing field, i.e. 
"Texaco," "Olive Garden," "Applebee's," etc. 

6. Click OK.  The item is saved and appears in the Favorite Finds Tab. 

You can also add a Point of Interest to your Favorite Finds directly from the Find Nearest Places window.  See 
Finding Items Near Your Current Location for more information. 
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Finding an Item Using the Favorite Finds Feature 
To find an item using the Favorite Finds feature: 
1. Right-click on the desired item in the Favorite Finds Tab and select Activate Favorite Find.  A Find 

Nearest Places window containing the Favorite Find information appears.  The nearest Points of Interest 
matching your Favorite Find criteria are displayed in the Places field. 

 

2. Click the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic Map. 

3. After selecting the desired Point of Interest, you can do any of the following: 

• To view the address, telephone number, and Place Category and Subcategory of the Point of Interest, 
click the Properties button. 

• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window 
appears.  See Editing Waypoint Properties for more information.  

• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your 
current location to the selected Point of Interest. 

• To close the Find Nearest Places window and leave the selected Point of Interest centered on the 
Graphic Map, click OK. 

• To close the Find Places window and return to the previous map display, click Cancel. 
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Editing a Favorite Find 
You can edit the information in your Favorite Finds. 

To edit a Favorite Find: 
1. Right-click on the desired item in the Favorite Finds Tab and select Favorite Find Properties.  The 

Favorite Find Properties window appears. 

 

2. Make the desired changes to the Favorite Find and click OK.  Your changes are saved. 
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Deleting a Favorite Find 
There are multiple methods to delete a Favorite Find from the Favorite Finds Tab: 

• Click the desired Favorite Find and click the Delete button . 

• Right-click on the desired Favorite Find and select Delete Favorite Find from the right-click menu. 

• Click the desired Favorite Find and select Delete Favorite Find from the Edit menu. 

• Click the desired Favorite Find and press the Delete key on your keyboard. 
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Working with Waypoints 
Understanding Waypoints 
A waypoint is a location that you mark on the map. It can be an address, an intersection, an existing map 
feature or point of interest, an empty spot on the map, or any other point you wish.  You can use waypoints to 
mark your favorite places, like your favorite restaurant, a friend's house, etc. 

You can mark waypoints directly on the map or by using the Find feature.  nRoute allows you to set your 
waypoint preferences to change the default method for displaying waypoints.   

Waypoints are shown on the map and in the Waypoints Tab at the bottom of the screen.  Select a waypoint in 
the Waypoints Tab to highlight the waypoint on the Graphic Map. 

You can edit waypoint properties after they have been marked.  You can select multiple waypoints in the 
Waypoints Tab and view or change their properties as a group. 

Waypoint Tips 
• To display a waypoint on the Graphic Map, right-click on the waypoint in the Waypoints Tab and select 

Show Selected Waypoint on Map. 

• You can perform a variety of tasks by right-clicking on a waypoint in the Waypoints Tab.  See Waypoint 
Right-Click Menu for more information. 

• Your waypoints are stored in memory for future use.  You can also save waypoints in a file on your 
computer.  See Saving Your Data for more information. 

For more information on waypoints, see the following topics: 

Using the Waypoints Tab  
Setting Waypoint Preferences  
Creating Waypoint Categories  
Marking Waypoints  
Setting Your Home Waypoint   
Editing Waypoint Properties  
Moving Waypoints  
Using Customized Waypoint Symbols  
Deleting Waypoints  
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Using the Waypoints Tab 
The Waypoints Tab shows a list of all the waypoints you have created.  You can access the Waypoints Tab by 
clicking on it or pressing F4 on your keyboard. 

 

If you select a waypoint in the Waypoints Tab, the Status Bar shows the distance and bearing from your current 
position to the selected waypoint. 

You can perform a variety of tasks by right-clicking on a waypoint in the list.  See Waypoint Right-Click Menu 
for more information. 

You can edit waypoint information using the Waypoint Properties window.  See Editing Waypoint Properties 
for more information. 

The Waypoints Tab contains the following fields (you may need to scroll right to view all the fields): 

Name—the name of the waypoint. 

Symbol—the waypoint symbol that appears on the Graphic Map. 

Comment—displays any comments you entered for the waypoint. 

Position—the latitude and longitude of the waypoint. 

Altitude—the altitude of the waypoint. 

Depth—the depth of the waypoint.   

Proximity—the proximity range of the waypoint. 

Temperature—the temperature of the waypoint. 

Display—describes how the waypoint appears on the Graphic Map: Symbol, Symbol & Name, or Symbol & 
Description. 

Date Modified—the date and time the waypoint was created or modified (if available). 

Show Waypoints in Category—select the desired waypoint category to filter the waypoints in the list and on 
the map.  Only the waypoints assigned to the selected category are displayed.  See Creating Waypoint 
Categories for more information.  

To re-order the waypoints in the list, click the name of the field you wish to sort the list by (for example, if you 
want to sort the list by waypoint name, click the Name field). 
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Creating Waypoint Categories 
You can create categories to help organize your waypoints.  For example, you could create a category called 
"Campsites" and assign the appropriate waypoints to that category. 

You can assign waypoints to a category using the Waypoint Properties window.  See Editing Waypoint 
Properties for more information. 

To create a waypoint category: 
1. Select Preferences from the Edit menu.  The Preferences window appears. 

2. Click the Waypoint Categories tab. 

3. Select the text in the first Category field, then enter the desired Waypoint Category name (i.e. "Campsites," 
"Rest Stops," etc.). 

4. Repeat Step 3 until all desired Waypoint Category names are entered. 

5. Click OK.  Your Waypoint Categories are saved. 
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Marking Waypoints 
You can mark waypoints by clicking on any point on the Graphic Map.  You can use the Find feature to find 
cities, addresses, intersections, or Points of Interest, then mark those items as waypoints.  You can also mark 
your current location as a waypoint. 

To mark a waypoint on the Graphic Map: 

1. Click the Waypoint Tool button . 

2. Click the desired location on the Graphic Map.  The Waypoint Properties window appears.  See Editing 
Waypoint Properties for more information. 

3. Enter the desired waypoint properties and click OK.  The waypoint appears on the map and in the 
Waypoints Tab at the bottom of the screen. 

 

To mark a waypoint using the Find feature: 
1. Find the desired item using the Find feature. 

2. Click the Make Waypoint button in the Find window. The Waypoint Properties window appears.  See 
Editing Waypoint Properties for more information. 

3. Enter the desired waypoint properties and click OK.  The waypoint appears on the map and in the 
Waypoints Tab at the bottom of the screen. 

 

To mark your current location as a waypoint: 

1. Click the Mark Current Position button . The Waypoint Properties window appears.  See Editing 
Waypoint Properties for more information. 

2. Enter the desired waypoint properties and click OK.  The waypoint appears on the map and in the 
Waypoints Tab at the bottom of the screen. 
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Setting Your Home Waypoint 
You can identify a waypoint as your home, which allows you to quickly route to that location. 

There are three methods for setting your home waypoint: 

Method 1: 

1. Click the Selection Tool button . 

2. Right-click on the desired location on the map and select Set as Home. 

Method 2: 
1. Right-click on an existing waypoint in the Waypoints tab, then select Waypoint(s) Properties.  The 

Waypoint Properties window appears. 

2. Enter "Home" in the Name field, then click OK. 

Method 3: 

1. Click the Route to Home button .  A message appears prompting you to set your home waypoint by 
right-clicking on the map or by using the Find feature. 

2. Click the Find Home button, then find the desired address, intersection, city, Point of Interest, or waypoint.  
See Using the Find Feature for more information. 

3. After you have found the desired location, click the Set as Home button. 
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Editing Waypoint Properties 
The Waypoint Properties window allows you to edit waypoints and customize the way they are displayed on 
the map.   

You can select multiple waypoints in the Waypoints Tab and view or change their properties as a group.  For 
example, you can select a group of waypoints and put them all in the same Category or give them all the same 
symbol.  NOTE: Not all fields can be edited in this manner. 

To edit waypoint properties: 
1. Activate the Waypoint Properties window by doing one of the following: 

• Click the Selection Tool button , then double-click the desired waypoint on the Graphic Map. 

• Double-click the desired waypoint name in the Waypoints Tab. 

• Click the desired waypoint(s) in the Waypoints Tab or on the Graphic Map.  To select multiple 
waypoints, press and hold the Ctrl or Shift key on your keyboard, then click the desired waypoints.  
After you have selected the desired waypoint(s), select Waypoint(s) Properties from the Edit menu. 

• Right-click the desired waypoint in the Waypoints Tab or on the Graphic Map, then select Waypoint(s) 
Properties from the right-click menu. 

The Waypoint Properties window appears. 

 

2. Use the following fields to edit the waypoint as desired: 

Name—enter a name for the waypoint, if desired.  The default name is a sequential number, plus any 
prefix you entered in the Waypoint Preferences window.  

Symbol—select the desired symbol to display on the map.  See Map Legend—symbols for a list of 
available symbols. 

Position—the coordinates of the waypoint.  You can enter new coordinates to change the position of the 
waypoint, if desired. 

Altitude—enter an altitude or leave the default Unknown box checked. 

Route To It—generates a route to the waypoint.  See Understanding Routes for more information. 

Show on Map—displays the selected waypoint on the Graphic Map. 

More/Fewer Details—click this button to toggle additional data fields in the Waypoint Properties window. 

3. To show additional details, click the More Details button.  Additional fields are displayed. 
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Depth—enter the depth or leave the default Unknown box checked. 

Proximity—enter the range for a proximity warning or leave the default Unknown box checked.  (This 
property is not used by all Garmin GPS systems.) 

Temperature—enter a temperature or leave the default Unknown box checked. 

Comment—enter a comment about the waypoint, if desired.  If you mark an existing map feature as a 
waypoint, nRoute includes the name of the feature in the Comment field.  If you create a waypoint at a 
location with no existing map features, the Comment field defaults to the date and time the waypoint was 
created. 

Display—select the method for displaying the waypoint on the map: symbol, symbol & name, or symbol & 
description.  You can change the default display setting in the Waypoint Preferences window. 

Date Modified—the date and time the waypoint was created or modified (if available). 

Categories—to assign this waypoint to a Waypoint Category, check the appropriate box.  You can assign 
a waypoint to as many categories as desired.  See Creating Waypoint Categories for more information. 

Link—this feature allows you to include a link to a file or URL containing information related to the 
waypoint.  For example, you could link to an electronic document containing a description of your waypoint, 
a digital photo you took while at the waypoint, or a Web site devoted to the area around the waypoint.  You 
can enter the desired file name/URL or click Browse to select the desired file.  Click the Open Link button 

 to activate the link. 

4. Click OK. Your changes are saved. 
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Moving Waypoints 
You can move an existing waypoint to a new location on the Graphic Map. 

To move a waypoint: 

1. Click the Selection Tool button . 

2. Right-click on the desired waypoint on the Graphic Map, then select Move Waypoint.  A small waypoint 
button and a curved arrow are displayed next to the mouse cursor. 

3. Click the new location on the map.  The waypoint moves to the new location. 

NOTE: You can also move a waypoint by changing its coordinates in the Position field of the Waypoint 
Properties window.  See Editing Waypoint Properties for more information. 
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Using Customized Waypoint Symbols 
You can add customized symbols for your waypoints.  nRoute includes 8 default custom waypoint symbols 
located on your computer in "My Documents/My Garmin/Custom Waypoint Symbols."  You can open these 
symbols with a graphic editor and use them as templates for creating your own symbols. 

You can add up to 64 custom waypoint symbols.  These symbols must be in .bmp format and must be named 
numerically from "000.bmp" to "063.bmp". 

After you have created customized waypoint symbols, you can add them to a waypoint using the Symbol field 
in the Waypoint Properties window.  See Editing Waypoint Properties for more information. 
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Setting Waypoint Preferences 
You can change the character limit for waypoint names as well as the default settings for creating waypoints, 
including the name prefix, symbol, and how the waypoint appears on the map. 

To set waypoint preferences: 
1. Select Preferences from the Edit menu.  The Preferences window appears. 

2. Click the Waypoint tab.  The Waypoint Preferences tab appears. 

 

3. Make any desired changes to the following fields: 

Limit application created names to XX characters―enter the desired number of characters or click the 
drop-down arrow to select a number.  This option is useful if you are sending waypoints to another GPS 
device that only accepts limited character names. 

Name Prefix―enter the desired prefix you want displayed in front of waypoint names.  The Example 
Name field changes to reflect the prefix you enter. 

Example Name―shows an example of the default waypoint name including the name prefix you entered. 

Symbol―select the desired default symbol you want to use to mark waypoints on the map. 

Display―select the desired method for displaying waypoints on the map: Symbol, Symbol & Name, or 
Symbol & Description. 

4. If you want to use these new settings when creating waypoints, select Use the choices above.  If you 
want to use the default settings when creating waypoints, select Let application decide its name, 
symbol, and display. 

5. Click OK to save your changes. 
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Deleting Waypoints 
There are multiple methods to delete a waypoint from the Waypoints Tab: 

• Click the desired waypoint and click the Delete button . 

• Right-click on the desired waypoint and select Delete Waypoint from the right-click menu. 

• Click the desired waypoint and select Delete Waypoint from the Edit menu. 

• Click the desired waypoint and press the Delete key on your keyboard. 

If you delete a waypoint by mistake, click the Undo button  or select Undo from the Edit menu. 
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Routing 
Understanding Routes 
nRoute can generate a route from your current location to one or more waypoints, addresses, intersections, 
Points of Interest, or any other points on the map.  nRoute displays the active route as a colored line on the 
Graphic Map.  The beginning point of a route appears in green and the route destination appears in red. 

 

The InfoBar and voice prompts inform you of upcoming maneuvers along the route and your arrival at the 
route destination.  nRoute also generates text-based driving directions to help you navigate. 

After you have created a route, you can use the Route Properties window to edit the route as desired, including 
adding, removing, or changing the order of the points along the route. 

Route Tips: 

• Press the Space Bar or click the Speak button  to activate the voice prompt. 

• nRoute generates a list of driving directions for each route.  You can view this list by clicking the Driving 
Directions Tab at the bottom of the screen or by pressing F9.  See Using the Driving Directions Tab for 
more information. 

• The Status Tab provides you with information about the route and navigation tools to help you reach your 
destination.  See Using the Status Tab for more information. 

• When you go off-course from an active route, nRoute automatically recalculates the route from your 
current position. 

• You can also click the Recalculate Route button  to manually recalculate the route at any time.  

• A route remains active until you deactivate it or activate a new route.  See Activating and Deactivating a 
Route for more information. 

• If there is a route active when you close nRoute, the route will be reactivated the next time you open 
nRoute. 

• In addition to auto-routes (automobile routes that follow streets and highways), nRoute allows you to 
create direct routes (straight line, "as the crow flies" routes). See Setting Route Preferences for more 
information. 

• Routes you have created and saved are displayed in the Saved Routes Tab along the bottom of the screen 
and stored in memory for future use. You can also save routes in a file on your computer.  See Saving Your 
Data for more information. 
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• You can create routes containing multiple points, called Vias.  See Creating a Saved Route Using the 
Route Properties Window for more information. 

• If you want nRoute to guide you from your current location back to the starting point of a route, select 
Return to Start of Route from the Route menu.  

• The Route menu and Route toolbar both contain shortcuts that allow you to perform many of the tasks 
described in this chapter. 

For more information on routes, see the following topics: 

Setting Route Preferences  
Creating a Route Using the Selection Tool  
Creating a Route Using the Find Places Feature  
Creating a Saved Route Using the Route Properties Window   
Creating a Route to Selected Waypoints  
Routing to Your Home Waypoint  
Saving an Active Route  
Using the Saved Routes Tab  
Activating and Deactivating a Route  
Using the Driving Directions Tab  
Editing a Route  
Simulating a Route  
Deleting a Route  
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Creating a Route Using the Selection Tool 
You can create an active route to any single point on the Graphic Map using the Selection Tool. 

To create a route using the Selection Tool: 

1. Click the Selection Tool . 

2. Right-click on the item or point on the Graphic Map that you want to route to, then select Route To It from 
the right-click menu.  The route is created, activated, and displayed on the Graphic Map.  Driving 
Directions are automatically generated. 

NOTE: Routes created using this method are not automatically saved in the Saved Routes Tab at the 
bottom of the screen.  See Saving an Active Route for more information. 
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Creating a Route Using the Find Places Feature 
You can create an active route to any city, address, intersection, waypoint, or Point of Interest using the Find 
Places, Find Nearest, or Recently Found Places features.  All Find Items are part of the basemap (which 
contains major cities) and detailed map data downloads (which contain Addresses, Map Features, and Points of 
Interest). 

To create a route using the Find Places feature: 

1. Click the Find Places , Find Nearest , or Recently Found Places  button. 

2. Find the desired item.  See Understanding the Find Feature for more information. 

3. When the desired item appears in the Find list, click it, then click Route To It.  The route is created, 
activated, and displayed on the Graphic Map.  Driving Directions are automatically generated. 

NOTE: Routes created using this method are not automatically saved in the Saved Routes Tab at the bottom of 
the screen.  See Saving an Active Route for more information. 
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Creating a Saved Route Using the Route Properties Window 
The Route Properties window allows you to create and edit routes containing one or more points (or "Vias").  It 
allows you to find addresses, intersections, waypoints, and Points of Interest and place them in the route in any 
order you wish.  You can also add, remove, and rearrange items in your route. 

After you create the route, you can activate it or save it. 

To create a saved route using the Route Properties window: 
1. Select Plan a Route from the Route menu.  The Route Properties window appears. 

 

2. Add Via points to the route using the following methods: 

• Click the Find Places , Find Nearest , or Recently Found Places  button in the toolbar, 
find the desired item, and click Add to Route.  See Understanding the Find Feature for more 
information. 

• If you have created waypoints and want to include them in the route, click Insert Waypoint, then 
select the desired waypoint.  To select multiple waypoints, press and hold the Ctrl or Shift key on your 
keyboard while clicking the desired waypoints.  When all the desired waypoints are selected, click OK. 

3. Edit the route as necessary.  See Editing a Route for more information. 

• If you want to view driving directions for the route, click the Directions tab.  From the Directions tab, 
you can print a list of directions by clicking Print Directions. 

4. After you have finished creating the route, do one of the following: 
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• If you want to save and activate the route, click the Activate button.  The route is activated and 
displayed on the Graphic Map.  It is also automatically saved and displayed in the Saved Routes Tab 
at the bottom of the screen. 

• If you want to save the route without activating it, click OK.  The route is created and automatically 
named using the first and last waypoints.  The route appears in the Saved Routes Tab at the bottom of 
the screen. 

NOTE: A message may appear stating that the selection will not be visible because of the current 
preference setting.  Click Yes to change your display preferences to show all routes on the Graphic Map, 
or click No to exit without changing your preferences.  See Setting Display Preferences for more 
information. 
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Creating a Route to Selected Waypoints 
You can select multiple waypoints in the Waypoints Tab and create a route to them using the Route Properties 
window. 

To create a route to selected waypoints: 
1. Click the Waypoints Tab. 

2. Click the desired waypoint(s).  To select multiple waypoints, press and hold the Ctrl or Shift key on your 
keyboard, then click the desired waypoints. 

3. Select Create Route Using Selected Waypoint(s) from the Edit menu.  The Route Properties window 
appears with the selected waypoints listed as Via points. 

4. Edit the route as necessary.  See Editing a Route for more information. 

NOTE: To change the order of the Via points in the route, select the desired Via point, then click the Move 

Up  and Move Down  Arrows to move the Via point in the list. 

5. After you have finished editing the route, do one of the following: 

• If you want to save and activate the route, click the Activate button.  The route is activated and 
displayed on the Graphic Map.  It is also automatically saved and displayed in the Saved Routes Tab 
at the bottom of the screen. 

• If you want to save the route without activating it, click OK.  The route is created and automatically 
named using the first and last waypoints.  The route appears in the Saved Routes Tab at the bottom of 
the screen. 
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Routing to Your Home Waypoint 
If you have set your home waypoint, you can quickly create a route to it from your current location. 

To route to your home waypoint, click the Route to Home button . 

• If you have already set your home waypoint, the route is created, activated, and displayed on the Graphic 
Map. 

• If you have not set your home waypoint, a message appears prompting you to set your home waypoint by 
right-clicking on the map or by using the Find feature.  See Setting Your Home Waypoint for more 
information.  After you set your home waypoint, click the Route to Home button again to create the route. 
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Saving an Active Route 
Routes created using the Selection Tool or the Find Places feature are not automatically saved.   

To save an active route: 
1. Select Save Active Route from the Route menu.  The route appears in the Saved Routes Tab.  The 

default route name is "Saved Active Route." 

2. Change the route name, if desired.  See Editing a Route for more information. 
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Using the Saved Routes Tab 
The Saved Routes Tab lists all the saved routes you have created using the Route Properties Window, as well 
as any active routes you have saved. 

You can access the Saved Routes Tab by clicking on it or pressing F5 on your keyboard. 

 

You can perform a variety of tasks by right-clicking on a route in the list.  See Saved Routes Right-Click Menu 
for more information. 

The Route Tab contains the following features: 

Name—the name of the route. 

Length—the total length of the route. 

Time—the estimated time required to navigate the route. 

Course—the directional heading for the route. 

Via Points—the number of via points included in the route. 

To re-order the routes in the list, click the name of the field you wish to sort the list by (for example, if you 
want to sort the list by route name, click the Name field). 
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Activating and Deactivating a Route 
Saved routes and new routes created using the Route Properties Window must be activated before you can 
begin navigation. 

To activate a saved route: 
1. Click the Saved Routes Tab. 

2. Right-click on the desired route and select Activate Route.  The route appears on the Graphic Map.  
Driving Directions are automatically generated. 

The route will remain active until you deactivate it or activate another route. 

To deactivate a route: 

1. Click the Stop Route button .  The route is deactivated. 

2. To reactivate the last active route, click the Resume Route button .  The route is reactivated. 
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Using the Driving Directions Tab 
When you activate a route, nRoute generates a list of driving directions, including maneuvers, estimated 
distance, and estimated time.  You can access the Driving Directions Tab by clicking on it or pressing F9 on 
your keyboard. 

 

The Driving Directions Tab contains the following features: 

Directions/Name—each maneuver along the route is listed in this column.  The highlighted maneuver appears 
in the Maneuver Preview window to the right of the list.  The upcoming maneuver in the route is also displayed 
in the InfoBar above the Graphic Map. 

Leg Length—the estimated distance from one maneuver to the next. 

Leg Time—the estimated time from one maneuver to the next. 

Maneuver Preview Window—when you click a maneuver in the list, a graphic preview of that maneuver 
appears in the Maneuver Preview window.  An arrow appears in the upper left corner of the window to indicate 
which direction is North. 

Show Selection on Map—click a maneuver in the list, then click this button to show the selected maneuver on 
the Graphic Map.  The Graphic Map automatically zooms to show the maneuver. 

Show Route on Map—click to show the entire route on the Graphic Map.  The Graphic Map automatically 
zooms to show the route. 

Destination—the route destination. 

Remaining Distance—the estimated remaining distance to the route destination. 

Remaining Time—the estimated remaining time to the route destination. 
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Editing a Route 
You can rename routes and print driving directions, as well as add, remove, and rearrange Via points in a route. 

To edit a route: 
1. Click the Saved Routes Tab. 

2. Right-click on the route you want to edit and select Route Properties.  The Route Properties window 
appears. 

 

3. Use the following features to edit the route as desired: 

Autoname—the Autoname feature automatically names the route based on the route's starting point and 
final destination.  For example, a route that begins at "Home" and ends at "113 Pine Street" is autonamed 
"Home to 113 Pine Street."  To rename the route, uncheck the Autoname box and enter the desired name 
in the Name field. 

Directions—this tab provides you with a list of driving directions.  From the Directions tab, you can print 
the list by clicking Print Directions. 

Edit Toolbar—Use the buttons on this toolbar to cut, copy, paste, and delete Via points from the route, or 
undo/redo the last action. 

Find Places , Find Nearest , and Recently Found Places  Buttons—to add Via points to the 
route using the Find Places feature, click these buttons in the toolbar, find the desired item, and click Add 
to Route.  See Understanding the Find Feature for more information. 
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Move Up  and Move Down  Arrows—select the desired Via point and click the Move Up or Move 
Down arrows to rearrange the position of that point in the route list. 

Properties—shows the properties of the selected Via point. 

Insert Waypoint—to insert a waypoint into the route, click this button, select the desired waypoint, and 
click OK.   

Invert - Inverts the order of all the Via points in the route. 

Recalculate—recalculates the driving directions for the route. 

Show Profile—click to display the Vertical Route Profile of the elevation of the Via points.  NOTE: This 
feature is only available on MapSource products that contain elevation data. 

Center Map on Selected Item—check this box to show the selected Via point in the center of the Graphic 
Map. 

Show on Map—shows the entire route on the Graphic Map. 

Link—this feature allows you to include a link to a file or URL containing information related to the route.  
For example, you could link to an electronic document containing a description of your route, a digital photo 
you took while on the route, or a Web site devoted to the area the route is in.  You can enter the desired 

file name/URL or click Browse to select the desired file.  Click the Open Link button  to activate the 
link. 

4. Click OK to save your changes. 
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Viewing a Vertical Route Profile 
If you are using maps that contain topographical data (such as U.S. TOPO 24K), you can view a vertical profile 
of your routes.  This vertical profile shows changes in elevation along your route.  NOTE: This feature is not 
available with all map products. 

To view a vertical route profile: 
1. Click the Saved Routes Tab. 

2. Right-click the route you want to edit and select Route Properties.  The Route Properties window 
appears. 

3. Click Show Profile.  The Vertical Profile window appears. 

 

The graph shows the distance and elevation information from the starting point to the ending point of your 
route.  The graph also includes symbols to represent waypoints along the route. 

4. Use the Zoom Tool  and the Zoom In  and Zoom Out  to zoom in and out on the profile as 
desired.  See Zooming In and Out on the Map for more information. 

5. Click the Red Marker Tool , then click a point on the vertical profile.  The point is marked with a red 
symbol.  The distance from the starting point of the route and the elevation of the selected point are 
displayed. 

6. Click the Blue Marker Tool , then click a point on the vertical profile.  The point is marked with a blue 
symbol.  The distance and elevation change from the red marker point to the blue marker point are 
displayed. 
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7. Click Close to exit the Vertical Profile window. 
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Simulating a Route 
nRoute can simulate GPS signals.  If you are indoors or do not have a GPS connected, you can use this feature 
to simulate driving a route. 

To simulate a route: 
1. Select Simulate a GPS from the Utilities menu.  nRoute begins simulating GPS signals. 

2. Activate a saved route or create a new route using any of the methods described in the Routing section.  A 
message box appears asking if you want to simulate the route. 

3. Click Yes.  nRoute simulates the route by moving the Vehicle icon along the route on the Graphic Map, 
giving voice prompts, and simulating information in the InfoBar, Status Tab, Driving Directions Tab, and 
Trip Computers Tab. 

To stop the simulation, deselect Simulate a GPS from the Utilities menu. 
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Setting Route Preferences 
You can modify route preferences to change the route style, calculation style, types of roads to avoid, and 
many other aspects of your routes. 

To set route preferences: 
1. Select Preferences from the Edit menu, then click the Routing tab.  The Route Preferences tab appears. 

 

2. Make the desired changes to the following fields: 

Route Style—select Use Auto-Routing to generate turn-by-turn automotive routes that follow the streets 
and highways on your map.  Select Use Direct Routes to generate straight-line, "as the crow files" routes.   

Calculation Style—select Faster Time or Shorter Distance.  NOTE: "Faster Time" routes usually utilize 
highways instead of side streets. 

Vehicle—select the desired vehicle from the list (bicycle, car, pedestrian, truck, etc.). 

Try to Avoid—select the types of roads and maneuvers you want nRoute to try to avoid incorporating into 
your route. 

Driving Speeds—select your average driving speeds for each type of road.  This helps nRoute estimate 
your driving time when generating a route and select the best route according to your driving habits.  To 
reset the speeds to the default numbers, click Reset. 

3. Click OK to save your changes. 
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Deleting a Route 
There are multiple methods to delete a saved route from the Saved Routes Tab: 

• Click the desired route and click the Delete button . 

• Right-click on the desired route and select Delete Route from the right-click menu. 

• Click the desired route and select Delete Route from the Edit menu. 

• Click the desired route and press the Delete key on your keyboard. 

If you delete a route by mistake, click the Undo button  or select Undo from the Edit menu. 
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Using Tracks 
Understanding Tracks 
As you navigate with nRoute, you can record your travels as "tracks."  A track consists of information gathered 
at various points along your path, including altitude, position, direction, speed, and time.  This information can 
be used to help you travel back to your point of origin.  You can use the Track Filter to set the parameters for 
how tracks are recorded. You can record a track whether or not you are navigating along a route. 

Tracks can be viewed on the Graphic Map, saved, and edited as desired. 

Tracks you have created are shown in the Tracks Tab along the bottom of the screen and stored in memory for 
future use.  You can also save tracks in a file on your computer.  See Saving Your Data for more information. 

For more information on tracks, see the following topics: 

Using the Tracks Tab  
Setting the Active Track Filter  
Recording a Track  
Viewing Active Track Properties  
Saving an Active Track  
Editing Track Properties  
Viewing a Track  
Deleting a Track  
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Using the Tracks Tab 
The Tracks Tab shows a list of all the tracks you have recorded.  You can access the Tracks Tab by clicking on 
it or pressing F6 on your keyboard.  

 

You can perform a variety of tasks by right-clicking on a track in the list.  See Tracks Right-Click Menu for 
more information. 

The Tracks Tab contains the following features: 

Name—the name of the track. 

Points—the number of points in the track. 

Start Time—the date and time you started recording the track. 

Elapsed Time—the total time elapsed while the track was being recorded. 

Length—the total length of the track. 

Area—the total area of the track in square feet. 

Avg. Speed—the average speed of the vehicle along the track. 

Record Active Track—check this box to begin recording a track.  Uncheck to stop recording. 

Display Active Track Properties—click to show the Active Track Properties window for the active track. 

Save Active Track Now—click to save the active track and begin recording a new active track. 

Active Track Filter—click to display the Track Filter. 

To re-order the tracks in the list, click the name of the field you wish to sort the list by (for example, if you 
want to sort the list by track name, click the Name field). 
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Recording a Track 
You can record a track using the Tracks Tab. 

To record a track: 
1. Click the Tracks Tab. 

2. Check the Record Active Track box  on the right-hand side of the Tracks Tab.  
nRoute begins recording the track. 

3. To stop recording, uncheck the Record Track box.  nRoute stops recording the track.  The track is 
automatically saved, and the track name appears in the Tracks Tab. 

 86 



Viewing Active Track Properties 
You can view (but not edit or change) the properties of a track as it is being recorded. 

To view active track properties: 
1. Click the Tracks Tab. 

2. Click the Display Active Track Properties button on the right-hand side of the Tracks Tab while a track is 
being recorded.  The Track Properties window appears for the active track. 

 

The Track Properties window contains the following information about each point along the track: 

Index—the sequential number of the track point. 

Time—the time at which the track point was recorded. 

Altitude—the altitude of the track point. 

Leg Length—the distance to the next track point. 

Leg Time—the time elapsed until the next track point was reached. 

Leg Speed—the average speed of the vehicle while travelling to the next point. 

Leg Course—the course the vehicle took to the next point. 

Position—the position of the track point. 

Track Statistics—the total points, length, area, elapsed time, and average speed of the track. 

3. To show the active track on the map, click the Show on Map button. 

4. To center the Graphic Map on a particular track point, check the Center map on selected item(s) box and 
select the desired point. 

5. Click Cancel to close the Track Properties window. 
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Saving an Active Track 
Tracks are automatically saved when you stop recording.  However, you can save an active track and 
immediately begin a new track without stopping recording. 

To save an active track: 
1. While a track is being recorded, click the Tracks Tab. 

2. Click the Save Active Track Now button.  The track is saved, and the track name appears in the Tracks 
Tab.  nRoute automatically begins recording a new track. 
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Editing Track Properties 
You can edit tracks that have been previously recorded.  This includes renaming tracks, rearranging points in a 
track, and viewing a vertical profile of a track. 

To edit track properties: 
1. Click the Tracks Tab. 

2. Right-click on the track you want to edit, then select Track Properties from the right-click menu.  The 
Track Properties window appears. 

 

3. Use the following features to edit the route as desired: 

Edit Toolbar—Use the buttons on this toolbar to cut, copy, paste, and delete Via points from the route, or 
undo/redo the last action. 

Center map on selected item—check the box to center the Graphic Map on any selected point in the 
track. 

Invert—click to reverse the order of the points in the track. 

Filter—click to display the Track Filter.  See Setting the Track Filter for more information. 

Show Profile—click to display a profile of the elevation of the points in the track. 

Show On Map—select a track point and click Show on Map to show the selected point on the Graphic 
Map. 

Link—this feature allows you to include a link to a file or URL containing information related to the track.  
For example, you could link to an electronic document containing a description of your track, a digital photo 
you took while recording the track, or a Web site devoted to the area you were in when you recorded the 
track.  You can enter the desired file name/URL or click Browse to select the desired file.  Click the Open 

Link button  to activate the link. 

4. Click OK to save your changes. 
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Viewing a Track 
You can view any saved track on the Graphic Map. 

To view a track: 
1. Click the Tracks Tab. 

2. Right-click on the track you want to view and select Show Selected Track on Map.  The selected track 
appears on the Graphic Map.  Active tracks are displayed as yellow dotted lines; inactive tracks are 
displayed as white dotted lines. 

 

NOTE: You may receive a message saying that the selection will not be visible because of the current 
preference setting.  Click Yes to change your display preferences to show all tracks on the Graphic Map, or 
click No to exit without changing your preferences.  See Setting Display Preferences for more information. 

NOTE: Route lines may cover portions of the track.  You may have to deactivate the active route in order 
to view the entire track.  See Activating and Deactivating a Route for more information. 
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Setting the Active Track Filter 
The Active Track Filter controls how often nRoute places points along a track.  nRoute records the time as well 
as your position and speed at each point along the track.  

To set the active track filter: 
1. Click the Active Track Filter button in the lower right-hand corner of the Tracks Tab.  The Track Filter 

window appears. 

 

2. Select the desired option for filtering the track: 

None—nRoute adds a new point to the track every second. 

Time—nRoute adds a new point to the track based on the time interval that you enter.  If you enter "30 
seconds," a new point is added to the track every 30 seconds. 

Distance—nRoute adds a new point to the track based upon the distance that you enter. If you enter "328 
feet," a new point is added to the track every 328 feet. 

Automatic—nRoute adds a new point to the track to best fit the user's path.  Adjust the selector to add 
more or fewer points to the track. 

3. Click OK to save your changes. 
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Deleting a Track 
There are multiple methods to delete a saved track from the Tracks Tab: 

• Click the desired track and click the Delete button . 

• Right-click on the desired track and select Delete Track from the right-click menu. 

• Click the desired track and select Delete Track from the Edit menu. 

• Click the desired track and press the Delete key on your keyboard. 

If you delete a route by mistake, click the Undo button  or select Undo from the Edit menu. 
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Reference 
Setting Preferences 
You can use the Preferences window to customize many features of nRoute to suit your needs.  To access the 
Preferences window, select Preferences from the Edit menu or press Ctrl+Shift+P on your keyboard. 

There are nine tabs in the Preferences window: Display, InfoBar, Units, Position, Waypoint, Time, Find, 
Navigation, and Routing.  Each tab contains several fields that allow you to adjust your preferences. 

Display Tab—allows you to customize the way the Graphic Map appears, including the level of map detail, 
visible routes, and colors.  See Setting Display Preferences for more information. 

InfoBar Tab—allows you to customize the information displayed in the InfoBar.  See Using the InfoBar for 
more information. 

Units Tab—allows you to select the type of units used for a variety of measurements.  The Units Tab contains 
the following fields: 

Distance/Speed—select Metric, Nautical, or Statute.  All distance or speed measurements reflect 
this setting.  

Heading—choose True, Automatic Magnetic Variation, User Magnetic Variation, Grid, or 
Cardinal Direction. True displays true north headings.  Automatic automatically calculates the 
magnetic variation for the geographical area.  Grid provides a true north heading as determined 
by the Position Format.  When User is selected, the field to the right is activated for manual entry 
of a magnetic variation. When Cardinal Direction is selected, your heading and/or course 
appears as N(orth), S(outh), E(ast) and W(est), etc. (Course information is found in the Saved 
Routes Tab).  

Altitude/Elevation—select Feet or Meters. 

Depth—select Feet, Meters, or Fathoms. 

Area—select Acres, Hectares, Square Feet, Square Miles, Square Meters, or Square 
Kilometers. 

Temperature—select Farenheit or Celsius. 

Position Tab—select from available grid formats or manually enter information for a user-defined grid.  The 
Position Tab contains the following fields: 

Grid—select a grid format from the drop-down list.  Refer to the Using a Garmin GPS with Paper 
Maps manual available at www.garmin.com. 

Datum—select from over 100 available map datums, allowing nRoute to easily match up with 
virtually any paper chart or map, or manually enter information for a user-defined map datum.  

Waypoint Tab—allows you to change your preferences for creating waypoints.  See Setting Waypoint 
Preferences for more information. 

Waypoint Categories Tab—allows you to create customized category names to help organize your 
waypoints.  See Creating Waypoint Categories for more information. 

Time Tab—sets up displayed time, either by the computer's local time zone, or by manually entering a UTC 
offset. 
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Find Tab—allows you to set the maximum number of places you want nRoute to find when searching for a 
particular feature, and set the maximum number of Recently Found places you want nRoute to remember.  See 
Setting Find Preferences for more information. 

Navigation Tab—sets preferences for active navigation, including voice-prompts and route recalculation.  The 
Navigation tab contains the following features: 

Guidance Prompt Selector—allows you to select how far away from a maneuver you want the 
voice prompt to speak.  Move the slider towards Less distance if you want to hear voice prompts 
closer to the maneuver.  Move the slider towards More distance if you want to hear voice 
prompts when you are farther away from the maneuver (which gives you more time to prepare for 
the maneuver). 

Voice Prompt—select Speak Button Only to hear voice prompts only when you click the Speak 
button or press the Space Bar on your keyboard.  Select Route Guidance to hear voice prompts 
for the next maneuver in an active route.  Select Route Guidance and Status to hear voice 
prompts for the next maneuver in the active route as well as voice prompts about satellite signals. 

Attention Tone—allows you to activate an attention tone that will sound on alerts or other 
messages from nRoute even if voice prompts are turned off. 

Off-Route Recalculation—select Automatic with Voice Alert to have nRoute automatically 
recalculate routes and play a voice prompt announcing the recalculation.  Select Automatic 
without Voice Alert for automatic recalculation without a voice prompt.  Select Ask Me for 
nRoute to ask you to if you want to recalculate.  Select Off to recalculate routes only when you 
click the Recalculate button. 

Bluetooth Tab—this tab is only available if you are using a Garmin GPS with Bluetooth® wireless technology.  
Use this tab to automatically turn the GPS off if it is unable to establish a Bluetooth connection.  You can also 
use this tab to automatically turn the GPS on if it is connected to external power.  

Routing Tab—sets preferences for routing calculations.  See Setting Route Preferences for more information. 
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Toolbars 
nRoute includes six toolbars that allow you to quickly perform many of the functions available in the menus.  
You can hold your mouse pointer over any button on any toolbar to display the name of that button. 

You can show or hide toolbars using the View menu.  See View Menu for more information.   

You can also show or hide toolbars by right-clicking on any toolbar and checking or unchecking the desired 
item. 

Edit Toolbar 

 

The Edit Toolbar contains functions of the Edit menu. You can select the Cut, Copy, and Paste functions, 
Delete selected items, and Undo the last user action.  After an "undo" is performed, the Redo button is 
activated, allowing you to revert to the last user action, or "redo" the "undo."  See Edit Menu for more 
information. 

View Toolbar 

 

The View Toolbar contains features of the View menu.  The View Toolbar allows you to Zoom In and Out, 
select a specific Zoom Scale, keep the vessel and/or maneuver visible, and change map orientation.  

If you have multiple MapSource products installed on your computer, the product selector is also displayed in 
the View Toolbar. 

. 
The product selector allows you to select a map product to display on the Graphic Map.  If you have only one 
MapSource product installed, the product selector is not displayed. 

See View Menu for more information. 

Find Toolbar 

 

The Find features let you search for an item and view it on the Graphic Map.  The Find buttons allow you to 
Find Places, Find Nearest Places, and view Recently Found Places.  See Find Menu and Understanding the 
Find Feature for more information. 

Route Toolbar 

 

The Route Toolbar contains buttons that are useful when navigating with an active route: Stop Route, Resume 
Route, and Recalculate Route.  See Route Menu and Understanding Routes for more information. 

The Route Toolbar also contains the Route to Home button.  See Routing to Your Home Waypoint for more 
information. 
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Tools Toolbar 

 
The Tools Toolbar contains features of the Tools menu.  You can directly select the Selection, Zoom, Hand, 
Waypoint, and Distance/Bearing Tools. See Tools Menu for more information. 

Utilities Toolbar 

 

The Utilities Toolbar contains three buttons: Mark Current Position, Select GPS, and Speak.  The Mark Current 
Position button allows you to mark your current location as a waypoint.  The Select GPS button allows you to 
choose the type of GPS your are using.  The Speak button activates the voice prompt.  See Utilities Menu for 
more information. 

Undocking the Toolbars 

The toolbars can be undocked and moved around the nRoute window for your convenience.  To undock a 
toolbar, place the mouse pointer over an open area on the toolbar, click and hold the left mouse button and 
move the toolbar to a different location. You can dock a toolbar on any side of the nRoute window.  To return a 
toolbar to its starting location, move it back to the top of the nRoute window. 
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Menus 
nRoute contains the following menus, which are accessible via the Menu Bar across the top of the screen: 

File Menu  
Edit Menu  
View Menu  
Find Menu  
Route Menu  
Tools Menu  
Utilities Menu  
Help Menu  
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File Menu 
The File menu contains the following options: 

Import (Ctrl + I)—allows you to select and open files.  See Opening Saved Data for more information. 

Export (Ctrl + E)—allows you to save your data on your computer.  See Saving Your Data for more 
information. 

Print (Ctrl + P)—prints the Graphic Map to the selected scale as displayed on the screen. 

Print Preview—shows a preview of how the Graphic Map will look when printed. 

Print Setup—allows you to choose options for printing the Graphic Map. 

Exit—exits the nRoute application. 
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Edit Menu 
The Edit menu contains the following options: 

Undo (Ctrl + Z)—reverts the previous action taken by the user. 

Redo (Ctrl + Y)—after an "undo" is performed, the Redo button is activated, allowing you to revert to the 
action that was just "undone." 

Cut (Ctrl + X), Copy (Ctrl + C), Paste (Ctrl + V)—these options work in nRoute like in many other 
Windows programs.  They allow you to cut or copy data to the Windows clipboard and paste it into different 
areas of nRoute or other Windows programs. 

Delete Item (Del)—deletes the selected item (waypoint, route, track, or Favorite Find). 

Select All (Ctrl + A)—selects all available items in the active Information Tab. 

New Saved Route (Ctrl + R)—allows you to create a new route using the Route Properties window.  See 
Creating a Saved Route Using the Route Properties Window for more information. 

Create Route Using Selected Waypoint(s) (Ctrl + Shift + R)—creates a route containing one or more 
waypoints you selected in the Waypoints Tab.  See Creating a Route to Selected Waypoints for more 
information. 

Duplicate Route—creates a copy of the selected route in the Saved Routes Tab.  The name of the duplicate 
route is the original route name with a sequential number added.  For example, if you copy a route named 
"Route Home," the duplicate route name is "Route Home 1." 

Properties—activates the Properties window for the selected waypoint, route, track, or Favorite Find. 

Preferences (Ctrl + Shift + P)—activates the Preferences window, which contains setup information for many 
functions within nRoute.  See Setting Preferences for more information. 
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View Menu 
The View menu contains the following options: 

Show Selected Item on Map (Ctrl + D)—when Waypoints, Routes, or Tracks Tabs are selected, this feature 
displays the selected item on the Graphic Map.  The menu heading changes to reflect the item(s) selected in the 
Information Tab.  For example, if a waypoint is selected in the Waypoints Tab, the menu will read Show 
Selected Waypoint on Map. 

Go to Position (Ctrl + G)—allows you to enter a latitude/longitude position to view on the Graphic Map.  See 
Finding a Latitude/Longitude Position for more information. 

Keep Vessel Visible (Ctrl + N)—select this option to keep the Vessel icon centered on the map.  A check 
mark next to this feature indicates that it is selected.  See Showing the Vehicle on the Map for more 
information. 

Keep Next Maneuver Visible (Ctrl + M)—select this option to show the next maneuver while navigating 
along a route.  A check mark next to this feature indicates that it is selected.  See Showing the Vehicle on the 
Map for more information. 

Keep Both Visible (Ctrl + B)—select this option to keep both the Vessel icon and the next maneuver visible 
along the route.  nRoute automatically zooms in and out to show the next maneuver.  See Showing the Vehicle 
on the Map for more information. 

Change Orientation (Ctrl + O)—toggles the map orientation between North Up and Track Up.  See Changing 
Map Orientation for more information. 

Zoom In (+)—zooms in on the map, showing a smaller area and more detail. 

Zoom Out ( - )—zooms out on the map, showing a larger area and less detail. 

Zoom In Max (Ctrl +)—zooms in to the smallest possible scale. 

Zoom Out Region (Ctrl - )—zooms out and centers on the region that is currently selected. 

Show/Hide GPS Map Detail—when GPS map details is shown, nRoute shows fully-detailed version of the 
map that is loaded, including all available map information (addresses, streets, Points of Interest, etc.).  Hiding 
GPS map detail shows a less-detailed version of the map, but enables faster map drawing.   

Show Crosshair (Ctrl + H)—select this option to display a crosshair indicating the center of the Graphic Map.  
A check mark next to this feature indicates that it is selected. 

Product—selects a MapSource product to display on the Graphic Map.  You can select an area from any 
MapSource product that has been installed on your computer and unlocked (if required). 

Zoom Scale—allows you to select the desired Zoom Scale from a list. 

Toolbars—allows you to activate the View, Utilities, Tools, and Edit Toolbars.  You can also select Show All 
Toolbars or Hide All Toolbars. 

Show InfoBar—allows you to toggle the InfoBar near the top of the screen.  When this item is checked, the 
InfoBar is displayed.  See Using the InfoBar for more information. 

Show Information Tabs (F12)—allows you to toggle the Information Tabs at the bottom of the screen on and 
off.  When this item is checked, the Information Tabs are displayed. 

Show Status Bar—allows you to toggle the status bar at the bottom of the screen on and off.  When this item 
is checked, the Status Bar is displayed. 

 100 



Find Menu 
The Find menu contains the following options: 

Find Places (Ctrl + F)—enables you to search for a city, point of interest, address, intersection, or waypoint 
and view it on the Graphic Map.  With some MapSource products, an Advanced "Find" dialog appears with 
additional menus to help narrow your search.  See Understanding the Find Feature for more information. 

Find Nearest Places (Ctrl + Shift + F)—allows you to find features nearest to your current position.  See 
Finding Items Near Your Current Location for more information. 

Recently Found Places (Ctrl + Alt + F)—activates a list of the places you have recently found using the Find 
feature.  See Finding Recently Found Places for more information. 

New Favorite Find—select this item to create a new Favorite Find.  See Understanding the Favorite Finds 
Feature for more information. 
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Route Menu 
The Route menu contains the following options: 

To Recently Found Place—select this option to create a route using the Recently Found Places window.  See 
Finding Recently Found Places for more information. 

To Nearest Place—select this option to create a route using the Find Nearest Places window.  See Finding 
Items Near Your Current Location for more information. 

To Feature—select this option to create a route using the Feature tab of the Find Places window.  See Finding 
Map Features for more information. 

To Waypoint—select this option to create a route using the Waypoints tab of the Find Places window.  See 
Finding Waypoints for more information. 

To Address—select this option to create a route using the Address tab of the Find Places window.  See 
Finding Addresses for more information. 

To Intersection—select this option to create a route using the Intersection tab of the Find Places window.  See 
Finding Intersections for more information. 

To City—select this option to create a route using the Cities tab of the Find Places window.  See Finding Cities 
for more information. 

To Home (Ctrl + Shift +H)—select this option to create a route to your home waypoint.  See Routing to Your 
Home Waypoint for more information. 

Find Home Location—this option allows you to set your home waypoint using the Find Places window.  See 
Setting Your Home Waypoint for more information. 

Set Current Location as Home—this option sets your current location as your home waypoint.  See Setting 
Your Home Waypoint for more information. 

Stop Route (Ctrl + Shift + S)—this option stops (deactivates) the active route.  See Activating and 
Deactivating a Route for more information. 

Resume Route—this option reactivates the route you just deactivated.  See Activating and Deactivating a 
Route for more information. 

Recalculate—this option recalculates the active route from your current position. 

Return to Start of Route—select this option to return to the starting point of the active route.  

Save Active Route—this option saves the active route.  See Saving an Active Route for more information. 

Activate Saved Route—select a saved route in the Saved Routes tab, then select this option to activate that 
route.  See Activating and Deactivating a Route for more information. 

Plan a Route (Ctrl + R) - Allows you to create a new route using the Route Properties window.  See Creating 
a Saved Route Using the Route Properties Window for more information. 
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Tools Menu 
The Tools menu contains the following options: 

Selection (S)—activates the Selection Tool, which allows you to select map features, waypoints, and routes 
directly on the Graphic Map. 

Zoom (Z)—activates the Zoom Tool, which allows you to draw a box around the area you want to zoom in on.  
The smaller the box, the more the map will zoom in.  See Zooming In and Out on the Map for more 
information. 

Hand (H)—activates the Hand Tool, which allows you to pan (move) the Graphic Map.  See Moving the 
Graphic Map for more information. 

Waypoint (W)—activates the Waypoint Tool, which allows you to create waypoints by clicking on the 
Graphic Map.  See Marking Waypoints for more information. 

Distance/Bearing (D)—activates the Distance/Bearing Tool, which allows you to measure the distance and 
bearing from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected, click a point 
on the Graphic Map, then click the point on the map you want to find the distance/bearing to.  The distance and 
bearing between the two points are shown in the Status Bar at the bottom of the nRoute application window.  If 
you click multiple points in a series, the Status Bar shows the distance, area, and bearing from the first point to 
the last point in the series. To stop using the Distance/Bearing Tool, press the Esc key on your keyboard or 
select a different tool. 
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Utilities Menu 
The Utilities menu contains the following options: 

Select GPS (Ctrl + Shift + D)—select this option to select the type of GPS connected to your computer—
Serial or USB. 

Rename USB GPS—select this option to rename your USB GPS.  This option is not available for serial GPS 
units. 

Get GPS Information—this option provides you with the Unit ID, Unit Type, and Software Version 
information for your GPS. 

Simulate a GPS—this option allows nRoute to simulate GPS signals.  If you are indoors or do not have a GPS 
connected, you can use this feature to simulate driving a route.  See Simulating a Route for more information. 

Unlock Regions (Ctrl + U)—select this option to unlock additional MapSource products.  See Unlocking 
Maps for more information. 

Set PC Clock—select this option to set the clock on your computer to GPS time. 

Mark Current Position (Ctrl + W)—select this option to mark your current location as a waypoint.  See 
Marking Waypoints for more information. 

Speak (Space Bar)—select this option to activate the voice prompt. 
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Help Menu 
The Help menu contains the following options: 

nRoute Help (F1)—select this option to activate the nRoute online help contents. 

Go to nRoute's Software Update Page—select this option to open a Web browser and access Garmin's 
nRoute Software Update page. NOTE: An Internet connection is required to access the software update Web 
page. 

About nRoute—select this option to display information about the software version of nRoute that you are 
using, including USB drivers (if applicable). 
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Right-Click Menus 
nRoute includes shortcuts to many functions of the main menus through the Right-Click menus.  With any tool 
selected (except the Zoom Tool), right-click anywhere on the Graphic Map and a menu of options appears for 
that feature or location.  Right-clicking on an item in one of the Information Tabs also activates a menu of 
options for that item. 

When there is more than one map feature at a given location (such as a waypoint that is part of a route), a list of 
those features appears first, with the name and type of feature.  Select the desired feature from the list, and the 
right-click menus for that feature appears. 

The Route To It, Find Nearest Places, New Waypoint, and Begin Measurement options are default right-
click options that are available almost every time you right-click on the Graphic Map.  If your GPS is not 
activated, the Set New Location option is also available.  See Map Feature Right-Click Menu for more 
information. 

For more information, see the following topics: 

Map Feature Right-Click Menu  
Waypoint Right-Click Menu  
Saved Routes Right-Click Menu  
Tracks Right-Click Menu  
Favorite Finds Right-Click Menu  
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Map Feature Right-Click Menu 
When you right-click on an open area or on a feature of the Graphic Map (such as a Point Of Interest or City, 
not a route or track), the following menu options may be displayed: 

Multiple Points—if there are multiple items at a single location on the Graphic Map, right-click on the 
location and a list of all the items at that location appears.  Select the desired item from the list and the normal 
right-click menu appears. 

Route To It—creates a route from your current location to the selected map location.  See Understanding 
Routes for more information. 

Find Nearest Places—locates the features closest to the point you click on.  See Finding Items Near Your 
Current Location for more information. 

New Waypoint—creates a new waypoint at the selected map location and accesses the Waypoint Properties 
dialog.  See Understanding Waypoints for more information. 

Begin Measurement—activates the Distance/Bearing Tool, allowing you to measure the distance and bearing 
from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected, click a point on the 
Graphic Map, then click the point on the map you want to find the distance/bearing to.  The distance and 
bearing between the two points are shown in the Status Bar at the bottom of the nRoute application window.  
To stop using the Distance/Bearing Tool, press the Esc key on your keyboard or select a different tool. 

Set as Home/Move Home Here—sets your home waypoint at the selected map location.  See Setting Your 
Home Waypoint for more information. 

Set New Location—this option is only available if your GPS is not activated or has not acquired satellites.  
This option allows you to set your current location to the appropriate place on the Graphic Map, which allows 
your GPS to acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current 
location and marks it with the Vessel icon on the Graphic Map.  

Show on Map—zooms to the selected map feature and displays it on the Graphic Map. 

Feature Properties—activates the Properties for the selected map feature, such as the address, phone number, 
and Place Category and Subcategory for a Point of Interest. 
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Waypoint Right-Click Menu 
When you right-click on a waypoint on the Graphic Map or in the Waypoints Tab, the following options may 
be displayed: 

Move Waypoint—activates the Selection Tool and allows you to move the selected waypoint to another 
location on the Graphic Map.  See Moving Waypoints for more information. 

Route To It—creates an active route to the selected waypoint from your current location.  See Creating a 
Route Using the Selection Tool for more information. 

Find Nearest Places—locates the features closest to the point you click on.  See Finding Items Near Your 
Current Location for more information. 

Create Route Using Selected Waypoint(s)—creates a route containing one or more waypoints you select in 
the Waypoints Tab.  See Creating a Route to Selected Waypoints for more information. 

New Waypoint—creates a new waypoint at the selected map location and accesses the Waypoint Properties 
dialog.  See Understanding Waypoints for more information. 

Begin Measurement—activates the Distance/Bearing Tool, allowing you to measure the distance and bearing 
from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected, click a point on the 
Graphic Map, then click the point on the map you want to find the distance/bearing to.  The distance and 
bearing between the two points are shown in the Status Bar at the bottom of the nRoute application window.  
To stop using the Distance/Bearing Tool, press the Esc key on your keyboard or select a different tool. 

Set as Home/Move Home Here—sets your home waypoint at the selected map location.  This option is only 
available if you have not yet set your home waypoint.  See Setting Your Home Waypoint for more information. 

Remove Waypoint from Route—if the selected waypoint is included in a saved route, this option removes the 
waypoint from that route. 

Cut/Copy/Paste—like the functions in the Edit Menu, these options allow you to cut, copy, and paste 
waypoints. 

Delete Waypoint—deletes the selected waypoint. 

Set New Location— this option is only available if your GPS is not activated or has not acquired satellites.  
This option allows you to set your current location to the appropriate place on the Graphic Map, which allows 
your GPS to acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current 
location and marks it with the Vessel icon on the Graphic Map. 

Show Selected Waypoint on Map—zooms to the selected waypoint and displays it on the Graphic Map. 

Waypoint Properties—activates the Waypoint Properties window, allowing you to review and edit the 
properties for the selected waypoint.  See Editing Waypoint Properties for more information. 
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Saved Routes Right-Click Menu 
When you right-click on a route name in the Saved Routes Tab, the following options are displayed: 

Invert Route Section—if a route contains multiple sections, this option allows you to invert the selected 
section of the route without inverting the entire route. See Editing a Route for more information.  

Activate Route—activates the selected route.  See Activating and Deactivating a Route for more information. 

Duplicate Route—creates a copy of the selected route in the Saved Routes Tab.  The name of the duplicate 
route is the original route name with a sequential number added.  For example, if you copy a route named 
"Route Home," the duplicate route name is "Route Home 1." 

Invert Route—reverses the waypoint order in the selected route.  This also reverses the route name, if the 
route name is the Autoname default.  If you have renamed the route, this option will not change the route name.  
See Editing a Route for more information. 

Recalculate Route—if you have modified the Auto-routing Preferences in the Route Preferences window, 
selecting this option recalculates the selected route according to the new preferences. 

Cut/Copy/Paste—like the functions in the Edit Menu, these options allow you to cut, copy, and paste routes. 

Delete Route—deletes the selected route.   

Show Selected Route on Map—zooms to the selected route and displays it on the Graphic Map.  NOTE: You 
may receive a message stating that the selection will not be visible because of the current preference setting.  
Click Yes to change your Display preferences to show all routes on the Graphic Map, or click No to exit 
without changing your preferences.  See Setting Display Preferences for more information. 

Route Properties—activates the Route Properties window, allowing you to review and edit the properties for 
the selected route.  See Setting Route Preferences for more information. 
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Favorite Finds Right-Click Menu 
When you right-click on an item in the Favorite Finds Tab, the following options are displayed: 

Activate Favorite Find—activates the selected Favorite Find.  See Finding an Item Using the Favorite Finds 
Feature for more information. 

Delete Favorite Find—deletes the selected Favorite Find. 

Favorite Find Properties—activates the Favorite Find Properties window for the selected Favorite Find.  See 
Editing a Favorite Find for more information. 

New Favorite Find—creates a new favorite find.  See Adding an Item to Your Favorite Finds  for more 
information. 
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Tracks Right-Click Menu 
When you right-click on a track on the Graphic Map or a track name in the Tracks Tab, the following options 
may be displayed: 

Route To It—creates a route from your current location to the selected map location.  See Understanding 
Routes for more information. 

Find Nearest Places—locates the features closest to the point you click on.  See Finding Items Near Your 
Current Location for more information. 

New Waypoint—creates a new waypoint at the selected map location and accesses the Waypoint Properties 
dialog.  See Understanding Waypoints for more information. 

Begin Measurement—activates the Distance/Bearing Tool, allowing you to measure the distance and bearing 
from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected, click a point on the 
Graphic Map, then click the point on the map you want to find the distance/bearing to.  The distance and 
bearing between the two points are shown in the Status Bar at the bottom of the nRoute application window.  
To stop using the Distance/Bearing Tool, press the Esc key on your keyboard or select a different tool. 

Cut/Copy/Paste—like the functions in the Edit Menu, these options allow you to cut, copy, and paste tracks. 

Delete Track—deletes the selected track. 

Set New Location— this option is only available if your GPS is not activated or has not acquired satellites.  
This option allows you to set your current location to the appropriate place on the Graphic Map, which allows 
your GPS to acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current 
location and marks it with the Vessel icon on the Graphic Map. 

Show Selected Track on Map—zooms to the selected track and displays it on the Graphic Map.  

Track Properties—activates the Track Properties window, allowing you to review and edit the properties for 
the selected track.  See Editing Track Properties for more information. 
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Important Information 
Cautions and Warnings 
CAUTION: Use the GPS receiver at your own risk.  To reduce the risk of unsafe operation, carefully review 
and understand all aspects of this Owner's Manual—and thoroughly practice operation using the simulator 
mode prior to actual use.  When in actual use, carefully compare indications from the GPS receiver to all 
available navigation sources, including the information from other NAVAIDs, visual sightings, charts, etc.  For 
safety, always resolve any discrepancies before continuing navigation. 

CAUTION: It is the user's responsibility to use this product prudently.  This product is intended to be used 
only as a navigational aid and must not be used for any purpose requiring precise measurement of direction, 
distance, location, or topography.  This product should not be used as an aid to determine ground proximity for 
aircraft navigation. 

CAUTION: The electronic chart is an aid to navigation and is designed to facilitate the use of authorized 
government charts, not replace them.  Only official government charts and notices to mariners contain all 
information needed for safe navigation—and, as always, the user is responsible for their prudent use. 

WARNING: The Global Positioning System (GPS) is operated by the United States government, which is 
solely responsible for its accuracy and maintenance.  The system is subject to changes which could affect the 
accuracy and performance of all GPS equipment.  Although the Garmin GPS receiver is a precision electronic 
NAVigation AID (NAVAID), any NAVAID can be misused or misinterpreted and, therefore, become unsafe. 

WARNING: For use in vehicles, it is the sole responsibility of the owner/operator of the GPS receiver to 
secure the unit so that it will not interfere with the vehicle's operating controls, obstruct the driver's view of 
driving conditions, or cause damage or personal injury in the event of an accident.  Do not mount the GPS 
receiver over air bag panels or in the field of air bag deployment.  Air bags expand with a rapid force that can 
propel objects in their path toward the driver or passengers causing possible injury.  Refer to air bag safety 
precautions contained in the vehicle's owner manual.  Do not mount the GPS receiver in a place where the 
driver or passengers are likely to impact it in an accident or collision.  The mounting hardware provided by 
Garmin is not warranted against collision damage or the consequences thereof. 

WARNING: For use in vehicles, it the sole responsibility of the driver of the vehicle to operate the vehicle in a 
safe manner, maintain full surveillance of all driving conditions at all times, and not become distracted by the 
GPS receiver to the exclusion of safe driving practices.  It is unsafe to operate the controls of the GPS receiver 
while you are driving.  Failure by the driver of a vehicle equipped with a GPS receiver to pay full attention to 
operation of the vehicle and road conditions while the vehicle is in motion could result in an accident or 
collision with property damage and personal injury. 

WARNING: This product, its packaging, and its components contain chemicals known to the State of 
California to cause cancer, birth defects, or reproductive harm.  This Notice is being provided in accordance 
with California's Proposition 65.  If you have any questions or would like additional information, please refer 
to our Web site at http://www.garmin.com/prop65. 

 

Map Data Information 
One of the goals of Garmin is to provide customers with the most complete and accurate cartography that is 
available to us at a reasonable cost.  We use a combination of governmental and private data sources, which we 
identify as required in product literature and copyright messages displayed to the consumer.  Virtually all data 
sources contain inaccurate or incomplete data to some degree.  This is particularly true for areas outside the 
United States, where complete and accurate digital data is either not available, or is prohibitively expensive.  
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If the data source is lacking a feature, or an item is mislocated or misidentified, it will be incorrectly identified 
or missing in the Garmin cartography product as well.  Each Garmin cartography product has its strengths and 
weaknesses, and not all are suitable for every purpose.  Please keep this in mind as you use and enjoy the 
benefits the cartography provides. 

Garmin encourages customers to report any errors found in our electronic maps by completing our online Error 
Reporting Form in the Cartography section of our Web site at: 
http://www.garmin.com/cartography/mapSource/errorForm.html. 

CAUTION: GARMIN MAKES NO WARRANTY AS TO THE ACCURACY OR COMPLETENESS OF 
THE MAP DATA IN THIS PRODUCT AND DISCLAIMS ANY AND ALL EXPRESS, IMPLIED, OR 
STATUTORY WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE.  IT IS THE USER's RESPONSIBILITY TO USE THIS 
PRODUCT PRUDENTLY.  THIS PRODUCT IS INTENDED TO BE USED ONLY AS A TRAVEL AID 
AND MUST NOT BE USED FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF 
DIRECTION, DISTANCE, LOCATION OR TOPOGRAPHY. 

 

Software Agreement 
THIS SOFTWARE IS OWNED BY GARMIN LTD OR ITS SUBSIDIARIES (HEREINAFTER 
COLLECTIVELY REFERRED TO AS "GARMIN") AND IS PROTECTED UNDER COPYRIGHT LAWS 
AND INTERNATIONAL COPYRIGHT TREATIES. THIS SOFTWARE IS LICENSED, NOT SOLD. THIS 
SOFTWARE IS PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT YOU MAY 
DO WITH THE PRODUCT AND CONTAINS LIMITATIONS ON WARRANTIES AND/OR REMEDIES. 

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS PRODUCT. INSTALLING, 
COPYING, OR OTHERWISE USING THIS PRODUCT INDICATES YOUR ACKNOWLEDGMENT 
THAT YOU HAVE READ THIS LICENSE AND AGREE TO ITS TERMS. IF YOU DO NOT AGREE, 
RETURN THE COMPLETE PRODUCT TO Garmin INTERNATIONAL. INC. PRODUCT SUPPORT, 1200 
EAST 151st STREET, OLATHE, KS 66062 WITHIN 10 DAYS OF THE DATE YOU ACQUIRED IT FOR 
A FULL REFUND. 

1. LICENSE: Garmin ("we" or "us") provides you with storage media containing computer software (the 
"Program") which may also include digital cartographic data and "online" or electronic documentation, and 
printed materials (together called the "Product") and grants you a limited non-exclusive license to use the 
Product in accordance with the terms of this License Agreement. The copyright and all other rights to the 
Product shall remain with us. You must reproduce any copyright or other notice marked on the Product on all 
copies you make. 

2. YOU MAY: a) install and use one copy of the Product on a single computer or network. This copy is to be 
used by only a single user at a time. If you wish to use the Product for more users, you will need an additional 
license for each user. 

b) make one copy of the Product for archive or backup purposes. 

c) use a copy of the Product on a home or portable computer if that copy is never loaded at the same time it is 
loaded on your primary computer. 

d) transfer the Product to someone else only if you assign all of your rights under this License, cease all use of 
the Product, erase or destroy any copy (including the hard disk copy) made in support of your use of  the 
Product, and ensure that the other person agrees to the terms of this License. 

3. YOU MUST NOT: a) make copies of the Product except as expressly permitted in Section 2 of this License. 
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b) translate, reverse engineer, decompile, or disassemble the Product except to the extent the foregoing  
restriction is expressly prohibited by applicable law. 

c) rent, lease, loan, sub-license, distribute, assign, or transfer the Product except as set out in Section 2 (d) 
above. 

d) modify the Product or merge all or any part of the Product with another program. 

4. TERM: This License shall continue for as long as you use the Product. However, this License will terminate 
automatically without notice from Garmin if you fail to comply with any of its terms or conditions. You must 
agree, upon termination, to destroy all copies of the Product. The Limitations of Warranties and Liability set 
out below shall continue in force even after any termination. 

5. LIMITATION OF WARRANTIES AND LIABILITY: THE PRODUCT IS PROVIDED ON AN "AS IS" 
BASIS, WITHOUT ANY WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF 
TRADE, OR COURSE OF DEALING. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE PRODUCT IS ASSUMED BY YOU. NEITHER WE NOR OUR DEALERS OR SUPPLIERS 
SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 
INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, 
INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA 
OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT 
RESPONSIBLE FOR CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGREGATE LIABILITY TO 
YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU FOR THE PRODUCT. THE LIMITATIONS 
IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A 
BREACH OF A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL BREACH. SOME 
STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY 
TO YOU. 

6. RESTRICTED RIGHTS: If this Product is acquired by or for the U.S. Government, then it is provided with 
Restricted Rights. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth 
in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013, or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 
52.227-19, or clause 18-52.227-86(d) of the NASA Supplement to the FAR, as applicable. The 
contractor/manufacturer is Garmin International, Inc., 1200 E. 151st Street, Olathe, KS 66062.  

7. EXPORT CONTROLS: You agree not to export or re-export the Product to any country in violation of the 
export control laws of the United States of America. 

8. GENERAL: This License is the entire agreement between us, superseding any other agreement or 
discussions, oral or written, and may not be changed except by a signed agreement. This License shall be 
governed by and construed in accordance with the laws of the State of Kansas, United States of America. If any 
provision of this License is declared by a court of competent jurisdiction to be invalid, illegal, or 
unenforceable, such a provision shall be severed from the License and the other provisions shall remain in full 
force and effect. 

 

Consumer Limited Warranty 
This Garmin product is warranted to be free from defects in materials or workmanship for one year from the 
date of purchase.  Within this period, Garmin will at its sole option, repair or replace any components that fail 
in normal use.  Such repairs or replacement will be made at no charge to the customer for parts or labor, 
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provided that the customer shall be responsible for any transportation cost.  This warranty does not cover 
failures due to abuse, misuse, accident or unauthorized alteration or repairs. 

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY 
ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, STATUTORY OR OTHERWISE.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, WHICH MAY VARY FROM STATE TO STATE. 

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY 
TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT.  Some states do not allow the 
exclusion of incidental or consequential damages, so the above limitations may not apply to you. 

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the purchase 
price at its sole discretion.  SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE REMEDY FOR 
ANY BREACH OF WARRANTY. 

To obtain warranty service, call your local Garmin authorized dealer.  Or call Garmin Product Support at one 
of the numbers listed on the right for shipping instructions and an RMA tracking number.  The unit should be 
securely packed with the tracking number clearly written on the outside of the package.  The unit should be 
sent, freight charges prepaid, to any Garmin warranty service station.  A copy of the original sales receipt is 
required as the proof of purchase for warranty repairs. 

Online auction confirmations are not accepted for warranty verification.  To obtain warranty service, an 
original or copy of the sales receipt from the original retailer is required.  Garmin will not replace missing 
components from any package purchased through an online auction. 
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